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A 
Primitive  

Input(s)  

Description  Examples  

 
abs  

number  

Stands for absolute. Reports the 
absolute value of its input.  

Given that there is a turtle on the 
page:  

sety abs xcor  

and  

true-or-false1  

true-or-false2  

 

(and  

true-or-false1  

true-or-false2  

true-or-
false3...)  

Reports true if all its inputs report 
true. If more than two inputs are 
used, and and its inputs must be 
enclosed in parentheses.  

See or and not.  

The result is just an example.  

show and pos = [0 0] 
heading = 0  
true  

announce  

word-or-list  

Displays the word-or-list message 
in an alert box. Clicking OK closes 
the box. If you drag the alert box to 
a new position while it is being 
displayed, this is the position where 
the next alert box is opened in the 
project.  

See question and answer.  

announce [Guess what's 
in the package...]  

answer  Reports the contents of the last 
answer typed in the question dialog 
box. It also reports special values 
after a dialog box have been used: 
OK if the OK button was used, the 
empty list if the Cancel button was 
used, or the button's label if a 
different button was used. The value 
reported by answer is always 
overwritten by the last usage of a 
question or a dialog box.  

See question and Dialog Boxes in 
the section Fundamentals in the 
Help System.  

Given that question was used 
with a yes-no answer:  

if answer = "yes  
   [setsh "happy]  
if answer = "no  
   [setsh "sad]  
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arctan  

number  

Stands for arc tangent. Reports the 
arc tangent (the inverse function of 
the tangent) of its input.  

See tan and cos.  

Given that a turtle exists on the 
page. The result is just an 
example.  

show arctan heading  
89.8090147756  

ascii  

char  

Stands for American Standard Code 
for Information Interchange. Reports 
the ASCII number which represents 
the character.  

See char.  

Given that there is a text box on 
the page:  

to encoder  
top repeat count text1 
[encode]  
end  
to encode  
select cf cut  
insert char  
(ascii clipboard) + 3  
end  

ask  

turtle-or-text-
name  

instruction-list  

ask  

list-of-names  

instruction-list  

Temporarily tells each element in 
the first input to run the instruction 
list. The first input can be the 
name(s) of one or many turtles or 
text boxes. Ask does not change 
the current turtle or text box. The 
apostrophe can be used to ask a 
turtle to report something.  

See also talkto.  

Given that t1, t2 and the text1 
exist on the page:  

ask [t1 t2] [clickon]  
ask "text1 [cleartext]  
t2, setpos ask " t1 
[pos]  
t2, setpos t1's " pos  
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B 
 

Primitive  

Input(s)  

Description  Examples  

 
back (bk)  

number  

Moves the turtle backwards. See 
also forward.  

Given that there is a turtle on the 
page:  

pd repeat 4 [bk 50 lt 
90]  

bg  Stands for background. Reports a 
number representing the color of the 
background. The background color 
is 0 (white) when MicroWorlds EX 
starts up  

repeat 140 [setbg bg 
+ 1] 
setbg 0  

bottom  Puts the cursor (insertion point), in 
the current text box, at the end of the 
text. Try using this command in a 
button so that you can see the effect 
on the cursor.  

See top, sol, eol, and eot?.  

Given that there is a text box on 
the page:  

pr "hello  
top pr "say  
bottom pr "there  

broadcast  

word-or-list  

Sends a message for all the turtles 
on the current page to hear. 
Broadcast triggers the instruction 
found in the OnMessage field in the 
Rules Tab of the turtle's backpack. If 
there is no instruction in a turtle's 
OnMessage field, the broadcasted 
message is ignored.  

See tell, message and sender. See 
also Rules Tab - OnMessage in the 
section Fundamentals in the Help 
System.  

In the Onclick field of t1's 
backpack:  

broadcast "here  

In the OnMessage field of t2's 
backpack:  

towards sender  

Click on t1  

butfirst (bf)  

word-or-list  

Reports all but the first component of 
a word or list.  

See butlast, first, and last.  

Given that there is a text box on 
the page:  

to triangle :word  
if :word = " [stop]  
pr :word  
triangle butfirst 
:word  
end  
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butlast (bl)  

word-or-list  

Reports all but the last component of 
a word or list.  

See butfirst, first, and last.  

Given that there is a text box on 
the page:  

to revprint :word  
if :word = " [pr " 
stop]  
insert last :word  
revprint butlast 
:word  
end  
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C 
 

Primitive  

Input(s)  

Description  Examples  

 
cancel  

instruction-list  

Stops the process given as 
input. The process must have 
been launched using launch, 
when, forever, buttons, or 
clickable turtles. The input 
must be the exact same 
instruction list that started the 
process.  

See Stopping Processes in 
the section More Techniques 
in the Help System.  

Given that mytune is an existing 
audio object:  

to delay  
launch [mytune]  
wait random 200  
cancel [mytune]  
end  

carefully  

word-or-list-to-
run1  

word-or-list-to-
run2  

Runs the first input, a word or 
list of instructions. If the first 
input contains an error, 
carefully runs the second 
input, a word or list of 
instructions and sets 
errormessage to the error 
that occurred. If there is no 
error in the first input, the 
second input is ignored.  

See carefully and Carefully 
in the section More 
Techniques in the Help 
System.  

To be tried twice.  

to createifdoesntexist  
carefully  
[newturtle "newborn]  
[]  
setx 30 st  
end  

cb  Stands for cursor back. Moves 
the cursor (insertion point) in 
the current text box to the 
previous character. Try using 
this command in a button so 
that you can see the effect on 
the cursor.  

See cf, cd, and cu.  

Given that there is a text box 
containing some text on the page:  

bottom  
repeat 5 [cb insert "x 
cb]  

cc  Stands for clear the Command 
Center. Clears the text in the 
Command Center.  

 

 

 

repeat 5 [show "flash 
wait 5 cc]  
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cd  Stands for cursor down. 
Moves the cursor (insertion 
point) in the current text box to 
the next physical line. Try 
using this command in a 
button so that you can see the 
effect on the cursor.  

See cu, cf, and cb.  

Given that there is a text box 
containing some text on the page:  

top  
repeat 5 [cd insert "x ]  

cf  Stands for cursor forward. 
Moves the cursor (insertion 
point) in the current text box to 
the next character. Try using 
this command in a button so 
that you can see the effect on 
the cursor.  

See cb, cd, and cu.  

Given that there is a text box 
containing some text on the page:  

top  

repeat 5 [cf insert "x ]  

cg  Stands for clear graphics. 
Clears the graphics on the 
page and returns the current 
turtle to its home position, 
pointing up. See also clean.  

Given that there is a turtle on the 
page:  

pd fd 50  
cg  

char  

number  

Stands for character. Reports 
the character represented by 
the ASCII number given as 
input. The number must be 
between 32 and 255. An 
exception is char 9, the tab 
character.  

See ascii.  

Given that there is a text box on the 
page:  

to decoder  
top  
repeat count text1 
[decode]  
end  

to decode  
select cf cut  
insert char  
(ascii clipboard) - 3  
end  

chdir  

pathname  

Stands for change directory. 
Changes the current drive 
and/or subdirectory name to 
path. To return to the desktop, 
use the volume name alone as 
input to chdir. Use vertical 
bars if the name contains 
spaces.  

See currentdir and 
directories.  

 

 

Given that these directories exist.  

chdir "Media  

chdir "|C:\MicroWorlds\My 
Work|  
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clean  Clears the graphics without 
changing any turtle's position.  

See also cg.  

Given that there is a turtle on the 
page.  

pd fd 50  
clean  

clearname  

word  

Clears a global variable from 
memory.  

See clearnames, names, 
make, and name.  

make "speed 5  
make "direction "right  
show :speed  
5  
clearname "speed  
show :speed  
speed has no value  

clearnames  Clears all the global variables 
from memory. MicroWorlds EX 
doesn't clear the variables 
when you open or create a 
new project. Therefore, it may 
be necessary to use 
clearnames when you start a 
new project.  

See names, clearname, 
make, and name.  

make "speed 5  
make "direction "right  
show :speed  
5  
clearnames  
show :speed  
speed has no value  
show :direction  
direction has no value  

cleartext (ct)  Clears the text in the current 
text box.  

Given that there is a text box on the 
page:  

repeat 5 [pr "line]  
cleartext  

clickoff  Simulates a mouse click on 
the current turtle, turning it off 
if it was on. This command 
has an effect only if the turtle 
is running its OnClick 
instruction.  

See clickoff, listen, and 
Rules Tab - Clickon in the 
section Fundamentals in the 
Help System.  

Given that there are turtles with 
OnClick instructions on the page:  

t1, clickon wait 30 
clickoff  
everyone [clickoff]  

clickoff  Simulates a mouse click on 
the current turtle, turning it off 
if it was on. This command 
has an effect only if the turtle 
is programmed to react to a 
mouse click.  

See clickon, listen, and 
Turtles and Clickon in the 
section More Techniques in 
the Help System.  

 

Given that there are several turtles 
on the page, with OnClick 
instructions:  

everyone [clickon]  
t1, clickoff  
everyone [clickoff]  
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clickon  Simulates a mouse click on 
the current turtle, turning it on 
if it was off. This command 
has an effect only if the turtle 
has an OnClick instruction.  

See clickon, listen, and 
Rules Tab - Clickon in the 
section Fundamentals in the 
Help System.  

Given that there are turtles with 
OnClick instructions on the page:  

t1, clickon wait 30 
clickoff  
everyone [clickon]  

clickon  Simulates a mouse click on 
the current turtle, turning it on 
if it was off. This command 
has an effect only if the turtle 
is programmed to react to a 
mouse click.  

See clickoff, listen, and 
Turtles and Clickon in the 
section More Techniques in 
the Help System.  

Given that there are several turtles 
on the page with OnClick 
instructions:  

t1, clickon  
everyone [clickon]  

clipboard  Reports the contents of the 
text clipboard. The clipboard 
contains the last text that has 
been cut or copied using the 
cut or copy command, or the 
equivalent Edit menu items or 
Toolbar buttons. The Clear 
menu item and the 
Delete/Backspace keys do not 
affect the clipboard.  

See also select and paste.  

Given that there is a text box 
containing some text on the page:  

top select bottom cut  
repeat 2 [pr clipboard]  

clone  

turtle-name  

Creates a copy of the named 
turtle. The new turtle takes the 
first available name on the 
current page (t followed by a 
number). Except for the name 
and position, the new turtle is 
a perfect clone of the original 
(backpack contents).  

Given that t1 exists on the page:  

clone "t1  

closeworksheet  Closes and saves the current 
Microsoft Excel file. This is the 
Excel file that was opened with 
the command 
openworksheet.  

See getcell and setcell.  

MicroWorlds EX will create this 
worksheet if it doesn't exist:  

openworksheet "graph 
"sheet1  
setcell 1 2 10  
closeworksheet  
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color  Reports the turtle's color as a 
number. Color reports a 
number, even if a name was 
used as input for setc.  

See also setc.  

Given that there's a turtle on page:  

show color  
9  
repeat 140 [setc color + 
1]  

colorunder  Reports the color under the 
center point of the current 
turtle as a number. 
Colorunder reports the color 
number if the color's on the 
background, on a drawing or 
stamped shape on the current 
page or on the Wallpaper.  

See also Private and Public 
Color Detection in the section 
Fundamentals in the Help 
System.  

Given that there's a turtle on the 
page. Place a turtle over a red 
drawing.  

if colorunder = 15  
[seth 1 fd 15]  

copy  Puts a copy of the selected 
text in the clipboard. It 
unselects the current 
selection.  

See cut, paste and select.  

Given that there is a text box 
containing some text on the page:  

top  
select  
bottom  
copy paste wait 20 ct  

cos  

number  

Stands for cosine. Reports the 
cosine of its input.  

See sin and tan.  

Given that a turtle exists on the page. 
The result is just an example.  

show cos heading  
0.5  

count  

word-or-list  

Reports the number of 
components in the word or the 
list.  

See item and textcount.  

Given that text1 exists on the page 
and it contains some text. The result 
is just an example.  

show count "hello  
5  
show count [hello there]  
2  
show count text1  
42  
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createprojectvar  

word-or-list  

Stands for create project 
variable. Creates a project 
variable represented by a 
command and a reporter. For 
example, if the project variable 
"amount" is created, the 
command setamount sets the 
variable's value, and amount 
reports its value. Project 
variables are saved with your 
project.  

The Project Tab shows the 
project variables. Individual 
variables can be removed with 
the right-click menu item 
Remove. You can also use 
the remove command to 
remove a project variable.  

See projectvars, make, 
remove and name. See also 
Local Variables and Global 
Variables in the section 
Programming in the Help 
System.  

createprojectvar "amount  
setamount 22  
show amount  
22  
createprojectvar [friends 
foes]  

cu  Stands for cursor up. Moves 
the cursor (insertion point) in 
the current text box to the 
previous physical line. Try 
using this command in a 
button so that you can see the 
effect on the cursor.  

See cd, cb, and cf.  

Given that there is a text box 
containing some text on the page:  

bottom  
repeat 5 [cu insert "x ]  

currentdir  Stands for current directory. 
Reports the current directory 
that was set.  

See chdir.  

The result is just an example.  

show currentdir  
C:\MicroWorldsEX\projects  

cut  Deletes the text selection in 
the current text box and puts a 
copy in the clipboard.  

See select, copy and paste.  

Given that there is a text box 
containing some text on the page:  

top  
select  
bottom  
cut wait 20 paste  
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D 
 

Primitive  

Input(s)  

Description  Examples  

 
delete  Deletes the character to the right of 

the cursor (insertion point) in the 
current text box.  

Given that there is a text box on 
the page:  

ct  
pr "unfair  
top  
delete delete  

difference  

number1  

number2  

Reports the result of subtracting 
number2 from number1.  

See - and minus.  

Given that these turtles exist on 
the page. The result is just an 
example.  

show difference 30 40  
show difference  
t1's "heading  
t2's "heading  
30  

directories  Reports a list of subdirectory 
names. To change directories 
through a command, use chdir.  

See chdir.  

The result is just an example.  

show directories  
Media My Work Projects  

A directory name made up of 
more than one word will look like 
two files in the list. Use make 
and names so that the actual 
names are enclosed in vertical 
bars. In this example, "My Work" 
is the name of one directory.  

make "dirs directories  
show names  
make "dir [Media |My 
Work| Projects]  
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distance  

turtle-name  

Reports the distance between the 
current turtle and the turtle 
indicated.  

See towards.  

Given that there are two turtles 
on the page, t1 and t2. Select 
Animate in each turtle's right-
click menu..  

t1, forever [if 50 < 
distance "t2  
[towards "t2]]  

Note:  

if 50 < distance "t2  

is equivalent to:  

if (distance "t2) > 50  

The parentheses are required in 
the second case because 
otherwise, MicroWorlds 
compares t2 and 50 instead of 
comparing (distance "t2) and 50.  

dolist  

range   

instruction-list  

Runs the instruction list for each 
item in a list. The first input, range, 
is a list with a temporary variable 
name and a list of items. The 
second input is a list of instructions 
that uses the variable name 
included in the first input. Be careful 
about the absence or presence of 
the ":" before the "i".  

See dotimes.  

Given that there is a turtle on the 
page:  

dolist [i [15 25 35]]  
[setc :i wait 4]]  

done?  

instruction-list  

Reports true if the process 
indicated is completed. The process 
must have been launched using 
launch or forever. The input must 
be an exact copy of the instruction 
list that started the process. Done? 
can be used as an input to waituntil 
in order to synchronize events.  

Given that jazz is an existing 
audio object and t1 is a turtle with 
an OnClick instruction:  

to dance  
launch [jazz]  
everyone [clickon]  
waituntil [done? 
[jazz]]  
everyone [clickoff]  
end  
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dotimes  

maximum  

instruction-list  

Runs the instruction list for all 
values starting with 0 up to the 
specified maximum value. The first 
input is a list with a temporary 
variable name and a maximum 
number. The second input is a list of 
instructions that uses the variable 
name included in the first input. Be 
careful about the absence or 
presence of the ":" before the "i".  

See dolist.  

Given that there is a text box on 
the page:  

dotimes [i 4] [pr se 
:i sqrt :i]  
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E 
 

Primitive  

Input(s)  

Description  Examples  

 
empty?  

word-or-list  

Reports true if the input is an 
empty word or empty list.  

Given that text1 exists on the 
page and it contains some text:  

show empty? "  
true  
show empty? []  
true  
show empty? text1  
false  
to insist  
question [Your name 
please...]  
if empty? answer 
[insist]  
end  

eol  Stands for end of line. Moves the 
cursor (insertion point) in the 
current text box to the end of the 
current logical line. Try using this 
command in a button so that you 
can see the effect on the cursor.  

See sol.  

Given that there is a text box on 
the page:  

top eol insert "!!!  

eot?  Stands for end of text. Reports 
true if the cursor (insertion point) 
in the current text box is at the end 
of the text. Eot? is generally used 
to stop a procedure that processes 
information in a text box using 
cursor (insertion point) commands 
like cd, eol, etc.  

See bottom.  

Given that there is a text box 
containing some text on the page:  

to addhyphens  
top  
doall  
end  

to doall  
sol insert "- eol  
if eot? [stop]  
cd  
doall  
end  

equal?  

word-or-list1  

word-or-list2  

Reports true if the two inputs are 
equal. The inputs may be words, 
numbers, or lists.  

See identical? and =.  

show equal? "A "a  
true  
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erfile  

pathname  

Stands for erase file. Erases any 
type of file if it is not locked. The 
input must be the name of a file in 
the current directory or a full 
pathname. Use vertical bars if the 
name contains spaces.  

Given that these files exist:  

erfile "farm  
erfile 
"C:\projects\farm  

If one of the elements of the path 
has spaces, vertical bars must 
enclose the whole path:  

erfile "|C:\My 
projects\farm|  

When there is more than one file 
with the same name, you need to 
add the extension.  

erfile "quake.mw2  

errormessage  Reports the last error message 
trapped by carefully. If 
errormessage reports an empty 
word, it means that the last 
operation using carefully did not 
report an error.  

See carefully and Carefully in the 
section More Techniques in the 
Help System.  

To be tried twice.  

to create  
carefully  
[newturtle "newborn]  
[show errormessage]  
setx 30 st  
end  

everyone  

instruction-list  

Makes all the turtles on the current 
page run the instruction, one after 
the other.  

See ask and talkto.  

Given that there are a few turtles 
on the page:  

everyone [glide -80 2]  

everyone  

instruction-list  

Makes all the turtles on the current 
page run the instruction, one after 
the other.  

See ask and talkto.  

Given that there are several 
turtles on the page:  

everyone [glide -80 2]  

exp  

number  

Stands for exponential. Reports 
the number to the power of the 
constant e.  

 

 

 

 

 

show exp 1  
2,71828182846  
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exporttext  

pathname  

text-name  

Exports the text found in the 
designated text box, the Command 
Center or public Procedures Tab 
to the file named indicated, in a 
unicode text file format.  

For the pathname, use a simple 
file name to save the file in the 
current directory or full or relative 
pathname to save the file in a 
different directory. If the file name 
has no extension, the resulting file 
is a txt (plain text) file. Add a rtf 
extension to the file name to get a 
Rich Text Format file.  

The second input, text-name, 
must be a text box name or the 
special word cc (to export the text 
in the Command Center) or 
procedures (to export the text in 
the public Procedures Tab).  

This command is equivalent to the 
Export Text item in the File menu.  

See a loadtext and importtext. 
See also Exporting Text in the 
section Fundamentals in the Help 
System.  

Given that text1 exists on the 
page.  

exporttext "story.rtf 
"text1  
exporttext 
"C:\mydir\cmds "cc  
exporttext "procs 
"procedures  

exportturtle  

pathname  

Saves the current turtle on disk. 
The turtle file contains the turtle 
and all the contents of its 
backpack. If the pathname is just 
a word, the turtle is saved in the 
current directory with the extension 
mwa. An exported turtle can be 
imported or dragged and dropped 
into a different project, or emailed.  

See importturtle.  

Given that there is a turtle on the 
page:  

exportturtle "model  
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F 
 

Primitive  

Input(s)  

Description  Examples  

 
files  

filetype  

Outputs a list of files of the given 
filetype in the current directory. If 
the input is "*", all file types are taken 
into account.  

See chdir and currentdir.  

Given that these files exist:  

show files "txt  
My Work report  

A file name made up of more 
than one word will look like two 
files in the list. Use make and 
names so that the actual names 
are enclosed in vertical bars. In 
this example, "My Work" is the 
name of one text file.  

make "texts files "txt  
show names  
make "texts [|My Work| 
report]  

fill  Fills a closed area with the turtle's 
pen color. If the area is not perfectly 
closed, the paint "leaks" onto the 
entire page. Fill works regardless of 
the turtle's pen state (up or down).  

See setc.  

Given that there is a turtle on the 
page:  

pd  
repeat 4 [fd 50 rt 90]  
rt 45 pu fd 5  
setc "yellow  
fill  

first  

word-or-list  

Reports the first component of the 
word or list.  

See butfirst, butlast, and last.  

Given that text1 exists on the 
page and it contains some text. 
The result is just an example.  

show first "hello  
h  
show first [Hello 
there]  
Hello  
show first text1  
T  
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fontsize  Reports the font size used at the 
insertion point in the current text box. 
If text that has more than one font 
size is selected, fontsize reports the 
size of the text that was selected 
last.  

See setfontsize.  

Given that there is a text box on 
the page:  

pr "hello  
setfontsize fontsize + 
10  
pr "there  

forever  

word-or-list-to-
run  

Runs the input repeatedly as an 
independent parallel process. Use 
cancel, the Stop All menu item (Edit 
menu) or button (Toolbar), or 
Ctrl+Break to stop the process.  

See launch and Timing and 
Synchronization in the section 
More Techniques in the Help 
System.  

Given that these turtles exist on 
the page:  

t1, forever [fd 5 / 4 
rt 2]  
t2, forever [fd 1 rt 
2]  

forward (fd)  

number  

Moves the turtle forward.  

See back.  

Given that there is a turtle on the 
page:  

pd  
repeat 4 [fd 50 rt 90 
wait 2]  

found?  Reports true if the last search 
instruction was successful.  

Given that there is a text box 
containing some text on the 
page:  

to replaceall :this 
:bythat  
search :this  
if not found? [stop]  
insert :bythat  
replaceall :this 
:bythat  
end  

fput  

word-or-list  

list  

Stands for first put. Reports the list 
created by adding the first input at 
the beginning of the second input. 
The second input has to be a list.  

See lput.  

 

 

 

 

 

show fput "a [e I o u 
y]  
a e I o u y  
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freeze  

object-name  

 

freeze  

list-of-names  

 

freeze  

page-name  

Freezes objects so that they cannot 
be moved, resized, or removed with 
the mouse. The input is the name of 
an object on the page, or a list 
containing many object names. A 
page name can also be used as 
input to freeze all the elements 
contained in that page.  

See unfreeze, freezebg and 
unfreezebg. See also Freezing 
Objects in the section 
Fundamentals in the Help System.  

Given that these objects exist on 
the page:  

freeze "t1  
freeze [button1 text1]  
freeze "page1  

freezebg  Stands for freeze background. 
Freezes the background graphics in 
their current state. You can still draw 
over the background and erase the 
new drawings, but the original 
background (before freezing) won't 
be erased.  

See unfreezebg, snapshot and 
restore.  

Given that there is a turtle on the 
page:  

pd fd 50  
freezebg  
repeat 45 [fd 40 rt 3]  
cg  
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G 
 

Primitive  

Input(s)  

Description  Examples  

 
get  

object  

property  

Reports a property of an object in 
the current project. The first input is 
the name of an object, a color, a 
page or the special word Project. 
The second input is a property 
name.  

Following is a list of the properties 
each object can have:  

Project:  

presentationmode? showtoolbar? 
showcc? showtabs? 
showstatusbar? showtechniques? 
dialogs  

Page:  

transition turtles texts buttons sliders 
melodies sounds music videos 
checkboxes roundbuttonsets 
listboxes dropdowns colordemons 
hyperlinks  

Turtle:  

visible? frozen? menu notes 
procedures onclick ontick 
ontouching onmessage onevent 
own on? colorname  

Button:  

visible? pos size onclick on? frozen? 
visible?  

Slider:  

visible? pos showname? limits value 
frozen? vertical? visible?  

 

 

Given that these objects exist on 
the page:  

show get "t1 "onclick  
show get "t1 "on?  
show get "button1 
"onclick  
show get "text1 "size  
show get "t1 "own  
show get "t1 "red  
show get "question 
"pos  
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Text:  

text visible? transparent? 
showname? frozen? pos size 
visible? onreadline, singleline?  

Public color detection:  

onturtle mouseclick  

Hyperlinks:  

visible? pos showname? frozen? 
on? link  

Media Objects:  

visible? pos showname? frozen? 
on?  

Additional for Melodies:  

instrument volume tempo  

Additional for Video:  

size  

Question and Announce:  

pos  

Choosers (round buttons sets, 
etc.):  

pos value visible? showname? 
frozen? labels (except for check 
boxes)  

See set.  

getcell  

row-number  

column-
number  

Reports the value of the cell 
specified by the row-number and 
column-number  of the current 
Microsoft Excel worksheet. Note 
that the command openworksheet 
makes an Excel worksheet available 
to MicroWorlds EX.  

See also setcell and 
closeworksheet. 

 

MicroWorlds EX will create this 
worksheet if it doesn't exist. The 
result is just an example:  

openworksheet "graph 
"sheet1  
show getcell 1 1  
50  
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getlabel  

object-name  

Reports the label (the text) of the 
current selection in the designated 
chooser (round button set, list box 
or drop down menu). The other 
option for reporting the current 
selection is to use the object name. 
show listbox1 reports the position 
of the current selection in the list of 
selections (reports 0 if nothing is 
selected) and show getlabel 
"listbox1 reports the label 
corresponding to that selection, as a 
long word.  

 
See Choosers and Dialog Boxes 
in the section Fundamentals in the 
Help System.  

Given that listbox1 exist on the 
page or in a dialog box:  

show getlabel 
"listbox1  
if (getlabel 
"radioset1) = "Yes  
[fd 50]  
setcolor getlabel 
"listbox1  

getpage  

page-name  

Displays the page. The input must 
be the name of a page in the current 
project. Typing the page name 
alone has the same effect.  

Given that there are several 
pages in the project (click on the 
page before you start because 
readchar works when the page is 
the current "active" area):  

to gotopagewhenkey 
:page  
let [a readchar]  
getpage :page  
end  

getproject  

pathname  

Gets the project indicated (the 
current project is not saved). The 
input must be the name of a project 
in the current directory or a full or 
relative path to access another 
directory.  

Getproject can load projects with 
extensions mwx (MicroWorlds EX), 
mw2 (MicroWorlds Pro 
uncompressed) or mwz 
(MicroWorlds Pro compressed).  

See saveproject. 

 

 

 

 

 

Given that these files exist:  

getproject "sunset  
getproject "|My 
Project|  
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giveturtle  

word  

Assigns a state variable to the 
current turtle and creates a 
command-reporter pair of primitives 
that can be used in the current 
project only: the word set followed 
by the name of the variable (for 
example, giveturtle "speed creates 
a setspeed command) and the 
name of the variable (in this 
example, the reporter speed).  

The State Tab of the turtle's 
backpack displays the giveturtle 
variables. The value of the variable 
can also be set by double-clicking 
on the variable name in the turtle's 
backpack.  

After a giveturtle instruction, the 
value of the variable is empty until it 
is set.  

See turtlesown and State 
Variables in the section 
Programming in the Help System.  

Given that there is a turtle on the 
page:  

giveturtle "hasrun  
sethasrun "false  
fd 50 sethasrun "true  
ifelse hasrun  
[announce [I'm tired]]  
[fd 50]  

glide  

distance  

speed  

Makes the turtle glide over the 
distance indicated. The second 
input sets the turtle's gliding speed. 
The maximum distance and 
maximum speed for glide are 9999 
and 99, respectively.  

Given that there is a turtle on the 
page:  

glide 50 1  
glide 100 0.1  

greater?  

number1  

number2  

Reports true if the first input is 
greater than the second input.  

See less? and >.  

Given that a turtle exists on the 
page:  

ifelse greater? xcor 
ycor  
   [setc "lime]  
   [setc "blue]  
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H 
 

Primitive  

Input(s)  

Description  Examples  

 
heading  Reports the current turtle's heading 

in degrees. The degrees correspond 
to those of a compass; 0 degrees is 
due North, 90 is East, 180 is South, 
and 270 is West.  

See seth, right, left.  

Given that there is a turtle on the 
page. Your result will differ:  

seth random 360  
show heading  
33  

hidetext  Hides the current text box. You 
cannot type in a hidden text box, but 
primitives such as print, insert, and 
cleartext still work. This command is 
equivalent to the Hide function in the 
text box's right-click menu on the 
page and in the Project Tab. Text 
boxes can also be made invisible 
and visible through their dialog 
boxes. Use the eye tool to see all 
hidden text boxes, as well as open 
their dialog boxes.  

See showtext.  

Given that there is a text box on 
the page:  

hidetext  
wait 20  
showtext  

home  Moves the turtle to the center of the 
page coordinates [0 0], pointing up.  

See setpos.  

Given that there is a turtle on the 
page:  

home pd  
repeat 50 [home  
setpos se random 100  
random 100]  

ht  Stands for hide turtle. Hides the 
current turtle.  

See st.  

Given that there is a turtle on the 
page:  

glide 60 2  
ht fd 50 st  
glide 60 2  
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I 
 

Primitive  

Input(s)  

Description  Examples  

 
identical?  

word-or-list1  

word-or-list2  

Reports true if both inputs are 
identical. A word and a list 
containing the same word are not 
identical. Corresponding characters 
of each input must match in terms 
of uppercase and lowercase letters. 
(Style, font, and text color are 
ignored.)  

See equal?.  

show identical? "a "a  
true  
show identical? "Hello 
"hello  
false  

if  

true-or-false  

list-to-run  

Runs the instruction list only if the 
true-or-false condition (first input) 
reports true.  

See ifelse.  

Given that these turtles exist on 
the page:  

to go  
t1, forever [fd 1 
check]  
end  

to check  
if 30 < distance "t2  
[towards "t2]  
end  

ifelse  

true-or-false  

list-to-run1  

list-to-run2  

Runs the first instruction list if the 
true-or-false condition (first input) 
is true. Runs the second instruction 
list if the true-or-false condition is 
false.  

See if.  

to quiz  
question [Washington 
is in...]  
ifelse member? answer  
[U.S.A. US USA U.S.]  
    [announce 
[Congrats!]]  
    [announce [Oops]]  
end  
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importtext  

pathname  

text-name  

Imports the text from the named file 
into the text box, Procedures Tab, 
or Command Center.  

For the pathname, use a simple file 
name to import a file from the 
current directory or full or relative 
pathname to import a file in a 
different directory.  

The input for text-name must be 
the name of a text box or the 
special words cc (Command 
Center) or procedures (public 
Procedures Tab).  

This command is equivalent to the 
Export Text item in the File menu.  

See exporttext, loadtext and 
Importing Text in the section 
Fundamentals in the Help System. 

Given that these files exist and 
text1 exists on the page:  

importtext "story.rtf 
"text1  
importtext 
"C:\mydir\cmds "cc  
importtext "brain 
"procedures  

importturtle  

pathname  

Imports the turtle file on the current 
page. The turtle file contains all the 
characteristics of the turtle (the 
contents of its backpack). A turtle 
file is created by the command 
exportturtle, or by the options 
Export and Mail it in the turtle's 
right-click menu.  

See exportturtle and Exporting, 
Importing and Mailing Turtles in 
the section Fundamentals in the 
Help System.  

Given that this turtle file exists:  

importturtle "model  

inback  Puts the current turtle behind all the 
other turtles on the page. A newly 
created turtle is always in front of 
the others.  

See infront.  

Given that t1 is facing t2, less 
than 100 steps away:  

t1, setc " red  
infront  
glide 100 0.1  
inback  
glide -100 0.1  

infront  Brings the current turtle in front of 
all the other turtles on the page. A 
newly created turtle is always in 
front of the others.  

See inback.  

Given that t1 is facing t2, less 
than 100 steps away:  

t1, setc " red  
infront  
glide 100 0.1  
inback  
glide -100 0.1  
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insert  

word-or-list  

Inserts the input at the cursor 
position, in the current text box. The 
text is NOT followed by a carriage 
return or a line feed.  

See print.  

Given that there is a text box on 
the page:  

settc "violet insert 
"w  
settc "red insert "o  
settc "orange insert 
"w  

int  

number  

Stands for integer. Reports the 
integer portion of its input.  

See round.  

Given that a turtle exists on the 
page:  

to snap  
setx 30 * int xcor / 
30  
sety 30 * int ycor / 
30  
end  

Put this procedure in a backpack, 
and the command snap in the 
OnClick field. Drag the turtle 
around and click on it.  

item  

number  

word-or-list  

Reports the specified element of a 
word or a list. The first input must 
be between 1 and the number of 
elements in the word or the list.  

Given that text1 exists on the 
page and it contains some text. 
The result is just an example.  

show item 2 "hello  
e  
show item 2 [Hello 
there]  
there  
show item 2 text1  
h  
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K 
 

Primitive  

Input(s)  

Description  Examples  

 
key?  Reports true if a key is being 

pressed on the keyboard. Use 
stopall to reset key? to false.  

See readchar.  

Given that there are several 
pages in the project (click on the 
page before you start because 
readchar works when the page is 
the current "active" area:  

to flip  
forever [nextpage wait 
10]  
waituntil [key?]  
cancel [nextpage wait 
10]  
end  

 
 



MicroWorlds EX Vocabulary 

33 

L 
 

Primitive  

Input(s)  

Description  Examples  

 
last  

word-or-list  

Reports the last component of the 
word or list.  

See first and butlast.  

Given that there is a text box on 
the page:  

to revprint :word  
if :word = " [pr " 
stop]  
insert last :word  
revprint butlast :word  
end  

launch  

word-or-list-to-
run  

Runs the input as an independent 
parallel process. If the process is 
launched from the Command 
Center, the cursor reappears 
immediately. Use cancel, the Stop 
All menu item (Edit menu) or 
button (Toolbar), or Ctrl+Break to 
stop the process.  

See forever and Timing and 
Synchronization in the section 
More Techniques in the Help 
System.  

Given that chopin is an existing 
audio object and fly is a procedure:  

launch [chopin]  
fly  
cancel [chopin]  

left (lt)  

number  

Turns the turtle to the left. The 
maximum value for number is 
9999.  

See right and seth.  

Given that there is a turtle on the 
page:  

seth 0  
lt 90  
seth 90  
repeat 5 [fd 50 lt 144]  

less?  

number1  

number2  

Reports true if the first number is 
less than the second number.  

See greater? and <.  

Given that a turtle exists on the 
page:  

ifelse less? xcor ycor  
   [setc "lime]  
   [setc "blue]  
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let  

list-of-names-
and-values  

Creates one or many temporary 
variables. The variables exist only 
while the procedure containing the 
let instruction and procedures 
called by this procedure are 
running. The input is a list of paired 
variable names and values. Let 
can only be used in a procedure. 
Use let when you know in advance 
the value of the variable.  

See local and Local Variables in 
the section Programming in the 
Help System.  

to pythagore :x :y  
let [sqrx :x * :x sqry 
:y * :y]  
op sqrt sum :sqrx :sqry  
end  

list  

word-or-list1  

word-or-list2  

 

(list  

word-or-list1  

word-or-list2  

word-or-
list3....)  

Reports one list made by 
combining the inputs (words or 
lists). If more than two inputs are 
used (or only one input), list and 
its inputs must be enclosed in 
parentheses. List maintains the 
structure of its input elements.  

See sentence.  

Given that there is a turtle on the 
page:  

show list 2 3  
2 3  
show list "a [b]  
a [b]  
show (list "a "b "c "d)  
a b c d  
make "x 10 make "y 20  
setpos list :x :y  

list?  

word-or-list  

Reports true if the input is a list.  

See word?.  

Given that there is a turtle on the 
page:  

show list? pos  
true  
show list? heading  
false  

listen  Sets the global "turtle who" (the 
turtle obeying instructions from the 
Command Center). This command 
allows you to change the global 
"turtle who" within a process that 
has been launched (for example, 
from a button).  

See Process and Who in the 
section More Techniques in the 
Help System. See also talkto and 
ask.  

 

 

Given that t1 and t2 exist on the 
page and that there is a button 
having t1, listen in its OnClick 
instruction.  

t2, clickon  
fd 30  
Click on the button  
fd 30  
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ln  

number  

Stands for natural logarithm. 
Reports the natural logarithm (the 
logarithm in base e) of the number. 
Inverse of exp.  

See log and exp,  

show ln 100  
4.60517018599  

loadpict  

pathname  

Stands for load picture. Loads the 
picture on the current page. The 
input must be the name of a picture 
file that MicroWorlds EX supports 
in the current directory or a full or 
relative path.  

See savepict and Importing 
Pictures in the section 
Fundamentals in the Help 
System.  

Given that these files exist:  

loadpict "scene  
loadpict 
"c:\projects\scene  
loadpict 
"media\tornado1.jpg  

loadshape  

pathname  

shape-number  

Loads the specified picture file into 
the specified shape spot in the 
public Shapes Tab. The picture file 
name becomes the name of the 
shape if there is no other shape 
with that name in that Tab.  

The file must be the name of a 
picture file that MicroWorlds EX 
supports in the current directory or 
a full or relative path. The shape-
number can be any number from 1 
to 128.  

See saveshape and Importing 
and Exporting Pictures in the 
section Fundamentals in the Help 
System.  

Given that these files exist:  

loadshape "volcano 20  
loadshape 
"c:\picts\volc.gif 20  

loadtext  

pathname  

Loads the text file in the current 
text box. For the pathname, use a 
simple file name to import a file 
from the current directory or full or 
relative pathname to import a file in 
a different directory.  

See importtext and Importing 
Text in the section Fundamentals 
in the Help System. 

 

 

 

 

Given that there is a text box on 
the page and that such files exist:  

loadtext "story  
loadtext 
"c:\projects\story  
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local  

word-or-list  

Makes the specified variable local 
to the procedure in which local is 
used. Local can only be used in a 
procedure. Use local when you 
have to perform some calculations 
on a variable within a procedure.  

See let, make, and name.  

Given that there are several pages 
in the project.  

to slideshow  
local "pictures  
make "pictures files 
"jpg  
slideone :pictures  
end  

to slideone :list  
if empty? :list [stop]  
cg  
loadpict first :list  
wait 30  
slideone bf :list  
end  

log  

number  

Stands for logarithm. Reports the 
logarithm of the number.  

See ln and exp.  

show log 100  
2  

lput  

word-or-list  

list  

Stands for last put. Reports the list 
created by adding the first input at 
the end of the second.  

See fput.  

show lput "y [a e I o 
u]  
a e I o u y  
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M 
 

Primitive  

Input(s)  

Description  Examples  

 
make  

word   

word-or-list  

Creates a variable named word 
and gives it the value word-or-list. 
These variables keep their values 
as long as you don't clear them or 
quit MicroWorlds EX. They are not 
saved with your project. If you want 
your variables to have specific 
values each time the project is 
loaded, you should have a startup 
procedure. To get the variable's 
value, use the colon in front of the 
variable name.  

See name, thing, clearname, 
names, and createprojectvar. See 
also Global Variables in the 
section Programming in the Help 
System,  

make "friends [Kim Lea 
Bob]  
show :friends  
Kim Lea Bob  
show first :friends  
Kim  

member?  

word-or-list1  

word-or-list2  

Reports true if the first input is a 
component of the second. Note that 
a list cannot be a component of a 
word.  

Given that there is a text box on 
the page and it contains some 
text:  

to quiz  
question [Washington is 
in...]  
ifelse member? answer 
[U.S.A. US USA U.S. 
|United States|]  
    [announce 
[Congrats!]]  
    [announce [Oops]]  
end  
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merge  

pathname  

word-or-list-of-
types  

Imports pages, procedures, or 
shapes from another project into 
the current project. The first input 
must be the name of a project in 
the current folder or a full or relative 
path to access a different folder. 
This is the project you want to 
import from.  

The second input can be the name 
of a specific page, a list of page 
names, the word procedures (to 
import the procedures from the 
project Procedures Tab and project 
variables), pages (to import all the 
pages), or shapes (to replace the 
shapes in the current project's 
Shapes Tab). Instead of using 
merge, we highly recommend 
using Import Turtle to import 
shapes and/or procedures included 
in a turtle's backpack. If there are 
names in the source project that 
are the same as those in the 
current project, the new names will 
be renamed with a number.  

Given that these files exist:  

merge "clocks 
"procedures  

Imports the procedures and 
project variables.  

merge "clocks "pages  

Imports all the pages.  

merge "clocks [page1 
page3]  

Imports individual pages.  

merge 
"C:\projects\scene 
"shapes  

Replaces public shapes in the 
current project (shape numbers 
that were not blank in the imported 
file).  

message  Reports the contents of the last 
message send by broadcast or 
tell. Message must be used in the 
OnMessage field of a turtle's 
backpack.  

See tell, broadcast and sender. 
See also Rules Tab - OnMessage 
in the section Fundamentals in the 
Help System.  

When you click on t1, t2 goes at 
position [100 100]:  

In the Onclick field of t1's 
backpack:  

broadcast [100 100]  

In the OnMessage field of t2's 
backpack:  

setpos message  

Click on t1  

minus  

number  

Reports the additive inverse of its 
input. Minus must be used to 
report the additive inverse of a 
variable (minus :num or minus 
heading instead of -:num or -
heading).  

See - and difference.  

 

 

Given that a turtle exists on the 
page. The result is just an 
example.  

setx minus ycor  
-55  
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mousepos  Stands for mouse position. 
Reports the page coordinates 
representing the current mouse 
position on the screen.  

See setpos.  

Given that there is a turtle on the 
page:  

setpos mousepos  
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N 
 

Primitive  

Input(s)  

Description  Examples  

 
name  

word-or-list  

word  

Creates a variable named word 
and gives it the value word-or-
list. These variables keep their 
values as long as you don't 
clear them or quit MicroWorlds 
EX. They are not saved with 
your project.  

See name, thing, clearname, 
names, and createprojectvar. 
See also Global Variables in 
the section Programming in the 
Help System.  

name [Kim Lea Bob] 
"friends  
show :friends  
Kim Lea Bob  
show first :friends  
Kim  

name?  

word  

Reports true if the input is the 
name of a variable.  

See make and name. See also 
Global Variables in the section 
Programming in the Help 
System.  

Define this procedure. Run the 
other instructions in the 
Command Center.  

to translate :word  
if name? :word  
[op thing :word]  
end  

make "table "mesa  
make "house "casa  
show translate "table  
mesa  

namepage (np)  

page-name  

Names the page being 
displayed with the input. 
Namepage corresponds to the 
Name Page function in the 
Pages menu. Once the page is 
named, the page-name is a 
command that displays that 
page.  

Given that this page doesn't 
already exist:  

namepage 
"presentation  

names  Reports the names of all the 
variables with their values.  

make "city "|New 
York|  
make "friends [Ted 
Lea]  
make "age 12  
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newbutton  

name  

[x y]   

instruction-list  

Creates a new button with the 
name and instruction specified, 
at the position [x y] indicated. 
The name cannot be more than 
32 characters (including 
spaces). The position [x y] is the 
top, left corner of the button. 
The button is created in the 
Once mode. It is sized to fit the 
instruction-list. At the time of 
creation, the label of the button 
is the same as its instruction. 
Use set to change the label.  

Given that this object doesn't 
already exist on the page:  

newbutton "mybutton  
[5 60]  
[note 65 5]  

The button shows its instruction 
as its label. Do this to set the 
label:  

set "mybutton "label 
"GO!  

newcheckbox  

name  

[x y]  

label  

Creates a new check box at the 
position indicated, with the label 
provided. The name of the 
check box reports its current 
state: true if it is checked, false 
otherwise.  

Given that this object doesn't 
already exist on the page and 
doodle is in the turtle's OnClick 
field in Forever mode:  

newcheckbox "pen [0 
0] "Draw  
to doodle  
ifelse pen [pd] [pu]  
fd 50 rt random 360  
end  

newdropdown  

name  

[x y]  

list-of-labels  

Creates a new drop down menu 
at the position indicated and 
containing the list of labels 
provided. The name of the drop 
down menu reports the position 
of the current selection in the list 
of selections. The other option 
for reporting the current 
selection is to use getlabel. 
Show dropdown1 reports the 
position of the current selection 
(reports 0 if nothing is selected) 
and show getlabel 
"dropdown1 reports the label 
(text) corresponding to that 
selection as a word.  

Given that this object doesn't 
already exist on the page:  

newdropdown 
"colselect [0 0]  
[Red Green Bleu]  
if colselect = 0  
[announce [Choose 
one]]  

newlistbox  

name  

[x y]  

list-of-labels  

Creates a new list box at the 
position indicated and 
containing the list of labels 
provided. The name of the list 
box reports the position of the 
current selection in the list of 
selections. The other option for 
reporting the current selection is 
to use getlabel. Show listbox1 
reports the position of the 
current selection (reports 0 if 
nothing is selected) and show 
getlabel "listbox1 reports the 
label (text) corresponding to that 
selection.  

Given that this object doesn't 
already exist on the page:  

newlistbox "colselect 
[0 0]  
[Red Green Bleu]  
if colselect = 0  
[announce [Choose 
one]]  
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newpage  Opens a new page called 
Pagex (x is the next available 
number).  

newpage  

newprojectsize  

[xsize ysize]  

Sets the page size on the 
computer screen for new 
projects. The input is a list of 
two numbers: the width and the 
height of the page in turtle 
steps. Before using 
newprojectsize, there must be 
an empty project on the screen. 
The page size of a project is 
saved with the project. The 
minimum size is 40 by 40 and 
the maximum size is 2000 by 
2000. The default project size is 
744 by 426 when the display 
setting (in the Control Panel) is 
1024 x 768 and 592 by 322 
when the display setting (in the 
Control Panel) is 800 x 600. 
This command corresponds to 
the New Project Size function 
in the File menu.  

See File Menu in the section 
Fundamentals and Posting 
Projects on the Web in the 
section More Techniques in 
the Help System.  

Choose New Project from the 
File menu so there is a perfectly 
empty project on the screen.  

newprojectsize [40 
40]  
newprojectsize 
"standard  

Resets the project size to the 
default size.  

newroundbuttonset 

name  

[x y]  

list-of-labels  

Creates a new round button set 
at the position indicated and 
containing the list of labels 
provided. The name of the 
round button set reports the 
position of the current selection 
in the list of selections. The 
other option for reporting the 
current selection is to use 
getlabel. Show 
roundbuttonset1 reports the 
position of the current selection 
(reports 0 if nothing is selected) 
and show getlabel 
"roundbuttonset1 reports the 
text of the selection.  

 

 

 

 

 

Given that this object doesn't 
already exist on the page:  

newroundbuttonset 
"colselect  
[0 0] [Red Green 
Bleu]  
if colselect = 0  
[announce [Choose 
one]]  
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newslider  

name  

[x y]  

[min max current]  

Creates a new slider using the 
specified name and at the 
position indicated. The position 
[x y] is the top, left corner of the 
slider. The last input is a list of 
three numbers representing the 
minimum, maximum, and 
current value of the slider. The 
minimum and maximum values 
are  

-9999 and 9999 respectively.  

Given that this object doesn't 
already exist on the page:  

newslider "step  
[100 100] [0 8 3]  
show step  
3  
setstep 5  
setstep [10 20 15]  

newtext  

name  

[x y]  

[xsize ysize]  

Creates a new text box using 
the name and size specified 
and at the position [x y] 
indicated. The position is the 
top, left corner of the box. The 
maximum [xsize ysize] is the 
size of the page in the project.  

Given that this object doesn't 
already exist on the page:  

newtext " mynotes [0 
0] [50 100]  
pr " Notes  

newturtle  

name  

Creates a new turtle with the 
name indicated. The new turtle 
appears at the position [0 0] and 
is hidden. Use st to make it 
visible. Newturtle makes the 
turtle that is created the current 
turtle.  

Given that this object doesn't 
already exist on the page:  

newturtle "newborn  
setx 30 st  

nextpage  Displays the next page in the 
page list. Pages are listed 
alphabetically in the page list. 
Rename your pages to create 
the desired sequence.  

See pagelist, prevpage and 
Pages Menu in the section 
Fundamentals in the Help 
System.  

Given that there are several 
pages in the project:  

repeat count pagelist  
[nextpage wait 10]  

not  

true-or-false  

Reports the logical inverse of its 
input.  

See and and or.  

Given that there is a turtle on 
the page:  

ifelse not xcor > 0  
   [setc "red]  
   [setc "blue]  
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note  

number-or-list-of-
numbers  

duration  

Plays a note using the current 
instrument. The first input is the 
MIDI note number and the 
second is the duration in tenths 
of a second. If the first input is a 
list of numbers, note plays a 
chord. Middle C is 60. The 
maximum number for note is 
127; the maximum duration is 
255. There can be no more than 
16 numbers in list-of-numbers. 

See rest.  

note 60 4  
note [72 76 79 84] 15  

number?  

word-or-list  

Reports true if the input is a 
number.  

See word? and list?.  

to insist  
question [How old are 
you?]  
if not number? answer  
   [insist]  
end  
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O 
 

Primitive  

Input(s)  

Description  Examples  

 
onreadline  

text-box-name  

instruction  

Sets the designated text box to the 
instruction, which will then be run 
when appropriate text is entered in 
the text box and Enter is pressed. 
The text box name tag changes to 
blue to show that an onreadline 
instruction is active. The second 
input is a procedure or MicroWorlds 
primitive that requires a number, 
word or long word (a sequence of 
characters including spaces) as 
input. Whatever text is typed into 
the text box becomes the input for 
this primitive or procedure. Pressing 
Enter runs the complete instruction. 

To turn off the effect of onreadline, 
make the second input an empty 
word as in:  

onreadline text-box-name "  

Onreadline is particularly useful for 
"faking" a Command Center in 
projects for the Web. For more 
information, see Making a Text 
Box into a Command Center in 
the section More Techniques in 
the Help System.  

Given that text1 exist on the 
page:  

onreadline "text1 "run  

Type fd 50 in that text box and 
press Enter.  

opacity  Returns the opacity of the current 
turtle's pen and shape. The value is 
a percentage.  

See setopacity.  

Given that there is a turtle on the 
page:  

pd setpensize 30  
setopacity 72  
repeat 36 [fd 10 rt 10  
setopacity opacity - 
2]  

opaque  

text-box-name  

Makes the designated text box 
opaque. This is equivalent to 
selecting Opaque in the text box's 
right-click menu, on the page or in 
the Project Tab. It is also equivalent 
to unchecking the box Transparent 
in the text box's dialog box.  

See transparent.  

Given that text1 exists on the 
page and it contains some text:  

transparent " text1  
opaque " text1  
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openworksheet  

pathname  

sheet  

Opens the specified file in Microsoft 
Excel on the specified worksheet. 
The first input must be the name of 
an Excel file in the current directory 
or a full or relative path. The second 
input must be the name of the 
sheet.  

The Excel related primitives only 
work if you have this program 
available on your computer.  

See getcell, setcell, and 
closeworksheet.  

MicroWorlds EX will create this 
worksheet if it doesn't exist:  

openworksheet "cards 
"sheet1  

or  

true-or-false1  

true-or-false2  

 

(or  

true-or-false1  

true-or-false2  

true-or-false3...)  

Reports true if any of its inputs 
report true. If more than two inputs 
are used, or and its inputs must be 
enclosed in parentheses.  

See and and not.  

Given that there is a turtle on the 
page:  

ifelse or xcor > 30 
xcor < -30  
   [setc "red]  
   [setc "blue]  

output (op)  

word-or-list  

Stops the procedure and reports a 
word or list. Output can only be 
used in a procedure.  

to double :x  
op :x + :x  
end  

show double 10  
20  
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P 
 

Primitive  

Input(s)  

Description  Examples  

 
pagelist  Reports a list containing the 

names of all the pages in the 
current project. The first name 
reported by pagelist is always 
the current page. The remaining 
pages in the project are listed 
alphabetically.  

Given that there are several 
pages in the project:  

repeat count pagelist  
[nextpage wait 10]  

parse  

word  

Turns character strings into plain 
lists. Spaces and carriage 
returns, and linefeed sequences 
contained in the character string 
become separators in the list. 
Parse can be used to turn the 
long word (a sequence of 
characters including spaces) 
reported by text boxes into lists 
of words.  

The result is just an example.  

question [Type in a 
sentence]  
show answer  
This is a sentence  
show count answer  
18  
show count parse 
answer  
4  

paste  Pastes a copy of the clipboard in 
the current text box. The 
clipboard contains the last text 
that has been cut or copied using 
the cut or copy command, or the 
equivalent Edit menu items and 
Toolbar buttons.  

See also select.  

Given that there is a text box 
containing some text on the 
page:  

top  
select  
bottom  
cut wait 5 paste 
paste  

pd  Stands for pen down. Puts down 
the pen of the current turtle. The 
turtle then leaves a trace when it 
moves, but not when it is 
dragged.  

See pu and pe.  

Given that there is a turtle on the 
page:  

repeat 6 [pu fd 10 pd 
fd 10]  

pe  Stands for pen erase. Puts down 
the eraser of the current turtle. 
The turtle erases the graphics 
when it moves.  

See pd and pu.  

Given that there is a turtle on the 
page:  

setc "red fill  
pe  
repeat 5 [fd 50 rt 
144]  
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pensize  Reports a number representing 
the pen size of the current turtle. 
The original pen size is 1. The 
maximum is 30.  

See setpensize.  

Given that there is a turtle on the 
page:  

setpensize 30  
repeat 29  
[fd 1 setpensize 
pensize - 1]  

pi  Reports the constant pi.  show pi  
3,14159265359  
seth 360 / pi  

pick  

word-or-list  

Reports an element chosen 
randomly from the word or the 
list. Picking from a word reports 
a character, picking from a list 
reports an element of the list (a 
word or a list).  

See textpick.  

Given that these turtles exist on 
the page. The result is just an 
example.  

show pick "hello  
e  
talkto pick [t1 t2 t3 
t4]  
fd 30  

pictlist  Stands for picture list. Reports a 
list containing the names of 
picture files in the current 
directory. Only the files with 
picture formats that MicroWorlds 
EX supports (created using 
savepict or other applications) 
are shown.  

See textlist, projectlist, and 
files. See also Importing and 
exporting Pictures in the section 
Fundamentals in the Help 
System.  

The result is just an example.  

show pictlist  
mybackground.bmp 
MW.gif  

A file name made up of more 
than one word will look like two 
files in the list. Use make and 
names so that the actual names 
are enclosed in vertical bars. In 
this example, "autumn scene.gif" 
is the name of one file.  

make "picts pictlist  
show names  
make "picts 
[mybackground.bmp 
|autumn scene.gif| ]  

placepict  

pathname  

[x y]  

size  

Stands for place picture. Imports 
a picture file, places it at the 
designated position, and adjusts 
its size to fit the size indicated. 
The first input is the file name in 
the current directory or a full or 
relative pathname; the second 
input is the position for the top, 
left corner of the picture, and the 
third input is the size of the 
image on the page, in x and y 
turtle steps.  

 

placepict "cat [0 0] [100 100]  
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pos  Stands for position. Reports the 
position of the turtle as a list of 
two numbers (co-ordinates). [0 0] 
is the position at the center of the 
page.  

See setpos.  

Given that there is a turtle on the 
page:  

show pos  
t1, setpos t2's "pos  

power  

number1  

number2  

Reports number1 raised to the 
power of number2.  

Given that a turtle exists on the 
page:  

pu home pd  
dotimes  
[i 24]  
  [sety (power :i 2) 
/ 10  
setx xcor + 1]  

presentationmode  Hides the Tabs, Command 
Center, Toolbar, Status Bar, and 
MicroWorlds EX menus. The 
project is centered on the screen 
and the background is filled in. 
Presentationmode is used to 
display completed projects. To 
return to MicroWorlds EX's 
regular mode, use 
presentationmode again (using 
a button or another clickable 
object), press Esc or double-click 
in the area surrounding your 
project. This command 
corresponds to the Presentation 
Mode item in the View menu and 
button in the Toolbar.  

presentationmode  

prevpage  Stands for previous page. 
Displays the previous page in the 
page list. Pages are listed 
alphabetically in the page list. 
Rename your pages to create the 
desired sequence.  

See pagelist, nextpage and 
Pages Menu in the section 
Fundamentals in the Help 
System.  

Given that there are several 
pages in the project:  

repeat count pagelist  
[prevpage wait 10]  

print (pr)  

word-or-list  

Prints a word or list in the current 
text box. The text is followed by a 
carriage return and line feed 
sequence.  

See insert.  

Given that there is a text box 
containing some text on the 
page:  

bottom  
pr "  
print [The End]  

 



MicroWorlds EX Vocabulary 

50 

product  

number1  

number2  

 

(product  

number1  

number2  

number3...)  

Reports the result of multiplying 
its inputs. If more than two inputs 
are used, product and its inputs 
must be enclosed in 
parentheses.  

show product 10 10  
100  

projectlist  Reports a list containing the 
names of MicroWorlds EX and 
MicroWorlds Pro projects in the 
directory (mwx, mw2, mwz files)  

See textlist, pictlist, and files.  

The result is just an example.  

show projectlist  
maze.mwz my 
adventure.mmwx  

A file name made up of more 
than one word will look like two 
files in the list. Use make and 
names so that the actual names 
are enclosed in vertical bars. In 
this example, "my adventure" is 
the name of one project.  

make "projects 
projectlist  
show names  
make "projects 
[maze.mwz |my 
adventure.mwx|]  

projectsize  Reports the current project size, 
in turtle steps.  

See newprojectsize.  

show projectsize  

projectvars  Stands for project variables. 
Reports the list of currently 
defined project variables.  

See createprojectvar.  

createprojectvar "age  
setage 12  
show projectvars  
age  

pu  Stands for pen up. Lifts up the 
pen of the current turtle. The 
turtle will not leave a trace when 
it moves.  

See pd and pe.  

Given that there is a turtle on the 
page:  

repeat 6 [pu fd 10 pd 
fd 10]  
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Q 
 

Primitive  

Input(s)  

Description  Examples  

 
question  

word-or-list  

Opens a dialog box displaying the 
question and an area to type the 
answer. Answer reports what was 
typed in the dialog box. If you write a 
very long question, only the part that 
fits is displayed. If you drag the 
dialog box to a new position while 
the question is being displayed, this 
is the position where the next 
question dialog is opened in the 
project.  

See answer.  

question [Are you in a 
good mood today? 
(answer yes or no)]  
question [|Are you in 
a good mood today?  
(answer yes or no)|]  

quotient  

number1  

number2  

Reports the result of dividing 
number1 by number2.  

show quotient 100 50  
2  
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R 
 

Primitive  

Input(s)  

Description  Examples  

 
random  

number  

Reports a random non-negative 
integer (including 0) less than 
number. The maximum number is 
9999.  

Given that a turtle exists on the 
page. The result is just an 
example.  

fd random 30 rt random 
60  

readchar  Pauses the execution and waits for 
a character to be typed on the 
keyboard.  

See key?.  

Given that there is a turtle on the 
page. Click on the page before 
you start because readchar 
works when the page is the 
current "active" area:  

to direct  
let [key readchar]  
if (ascii :key) = 37  
    [seth 270]  
if (ascii :key) = 38  
    [seth 0]  
if (ascii :key) = 39  
    [seth 90]  
if (ascii :key) = 40  
    [seth 180]  
end  

Animate the turtle and create a 
button with the instruction Direct 
in Forever mode. You can now 
use the arrow keys to control the 
turtle.  

recycle  Frees up unused MicroWorlds EX 
memory space. MicroWorlds EX 
automatically recycles by itself to 
free up space. Therefore, only use 
the recycle command when you do 
not want the automatic recycle to 
occur when you are running a 
program.  

 
See space.  

 

 

show space recycle 
show space  
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remainder  

number1  

number2  

Reports the remainder after 
number1 is divided by number2. 
The remainder of a negative 
number is negative. If number1 
and number2 are non-integers, 
they are rounded to the nearest 
integers.  

Given that a turtle exists on the 
page. The result is just an 
example:  

show remainder 100 3  
1  
show remainder xcor 10  
8  

remove  

object-name  

 

remove  

page-name  

 

remove 

variable-name  

Deletes an object, page, project 
variable created with 
createprojectvar or a turtle 
variable created with turtlesown or 
giveturtle. If the named object is 
not on the current page, 
MicroWorlds looks for it on the 
other pages in the project. If the 
input to remove is procedures, the 
Public Procedures Tab is cleared. If 
you remove the only page of a 
project, a new page called Page1 is 
created. You can also remove 
objects with the Remove option in 
the object's right-click menu on the 
page or in the Project Tab.  

Given that t1 exists on the page:  

remove "t1  

rename  

object-name  

new-object-
name  

Sets a new name for the object or 
the page.  

Given that these objects exist:  

rename "t1 "myfriend  
rename "text1 "mynotes  
rename "page1 "intro  

repeat  

number   

instruction-list  

Runs the list of instructions the 
specified number of times.  

See dotimes and dolist for more 
advanced features.  

Given that there is a turtle on the 
page:  

pd  
repeat 96 [bk 40 fd 40 
rt 4]  

rerandom  Reproduces the same sequence of 
numbers generated by random. 
After running rerandom, random 
with the same input generates the 
same sequence of numbers the 
next time.  

rerandom  
repeat 2 [show random 
10]  
8  
5  
rerandom  
repeat 2 [show random 
10]  
8  
5  
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resetdialog  

name-of-dialog-
box  

Resets all the choosers in the 
named dialog box to their default 
values. You can set the default 
value or round button sets, list 
boxes and drop down menus in 
their own dialog boxes. Without a 
resetdialog, the values previously 
set when you last used the dialog 
box are maintained when the dialog 
box is reopened.  

See Dialog Boxes in the section 
Fundamentals in the Help System. 

Given that dialog1 exists:  

dialog1  

Make some changes to the 
choosers. Click on Cancel.  

dialog1  

The selections you made earlier 
are still present in the dialog box. 
Click on OK.  

resetdialog "dialog1  
dialog1  

The values are reset to those set 
in the dialog box editor.  

resett  Stands for reset timer. Resets the 
timer to 0. The timer starts when 
you start up MicroWorlds EX.  

See timer.  

Define this procedure and run the 
other instructions in the 
Command Center.  

to reflex  
resett  
setnum1 1 + random 10  
setnum2 1 + random 10  
question  
(se [What is] num1  
   "times num2 [?])  
ifelse answer = num1 * 
num2  
   [announce se timer 
/ 10 "sec]  
   [announce [Wrong 
answer]]  
end  

Type this in the Command 
Center:  

createprojectvar "num1  
createprojectvar "num2  
reflex  

resetvideo  

word  

Resets the video to the beginning.  Given that this object exists on 
the page:  

resetvideo "video1  
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rest  

duration  

Inserts a rest in a sequence of 
notes. The duration is in tenths of 
a second, and has a maximum of 
255.  

See note.  

to song  
note 60 5  
note 62 5  
note 64 5  
rest 10  
note 60 5  
note 62 5  
note 60 15  
end  

restore  Restores the background to the 
way it was the last time a snapshot 
command was issued. The turtle's 
position does not change. 
Everything else remains intact. See 
snapshot, freezebg and 
unfreezebg.  

Given that there is a turtle on the 
page:  

pd lt 11 fd 9999  
snapshot  
rt 22 fd 9999  
restore  

right (rt)  

number  

Turns the turtle to the right. The 
maximum value for number is 
9999.  

See left and seth.  

Given that there is a turtle on the 
page:  

seth 0  
seth 90  
rt 90  
repeat 5 [fd 50 rt 
144]  

round  

number  

Reports the number given as input 
rounded to the nearest integer. 
Numbers ending with .5 are 
rounded to the higher integer.  

Given that a turtle exists on the 
page:  

to snap  
setx 30 * round xcor / 
30  
sety 30 * round ycor / 
30  
end  

Put this procedure in a backpack, 
and the command snap in the 
OnClick field. Drag the turtle 
around and click on it.  

run  

word-or-list-to-
run  

Runs (executes) a word or an 
instruction list.  

See onreadline.  

Given that text1 exists on the 
page and it contains a 
MicroWorlds EX instruction:  

run text1  
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S 
 

Primitive  

Input(s)  

Description  Examples  

 
savepict  

pathname  

Stands for save picture. Saves the 
current page and its background 
as a picture file. The default file 
format (if you don't specify a format 
using an appropriate graphic file 
extension) is PNG.  

When you use the savepict 
command, the turtles, buttons, text 
boxes, and other objects are not 
part of the background. Stamped 
images and stamped text are part 
of the background. Use the File 
menu function Export Page Image 
to save the picture of the page 
including all objects.  

Savepict saves the file in the 
current directory unless you use a 
full or relative pathname.  

See Importing and Exporting 
Pictures in the section 
Fundamentals in the Help 
System.  

savepict "scene  
savepict 
"C:\projects\scene  
savepict "scene.jpg  

saveproject  Saves the current project without 
closing it. The project must have a 
name in order for this command to 
work. This is equivalent to the 
Save item in the File menu. Use 
this primitive if you want to save 
your project before getting another 
project with getproject.  

saveproject  

saveshape  

pathname  

number  

Saves the specified shape from 
the project Shapes Tab as a 
picture file. Use a simple file name 
to save the file in the current 
directory or full or relative 
pathname to save the file in a 
different directory.  

If the file name has no extension, 
the resulting file is a png image. 
Add a jpg, gif or bmp extension to 
the file name to get a specific file 
format.  

Given that there is a turtle on the 
page with shapes in the spot 1.  

saveshape "moon 1  
saveshape "moon.jpg 1  
saveshape 
"c:\graph\moon.jpg 1  
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savetext  

pathname  

Saves the text found in the current 
text box in a unicode text file 
format.  

The input can be a file name with 
or without an extension (and the 
file will be saved in the current 
directory) or a full or relative path. 
This command is equivalent to the 
Export Text item in the File menu. 
To save the Procedures Tab or the 
content of the Command Center as 
a text file, see exporttext.  

See loadtext and textlist. See 
also Exporting Text in the section 
Fundamentals in the Help 
System.  

Given that there is a text box on 
the page and it contains some 
text:  

savetext "story  
savetext 
"C:\proj\story  
savetext "story.rtf  

search  

word  

Tells MicroWorlds EX to search 
and select (highlight) the word in 
the current text box. Nothing 
happens if the word is not found., 
except for the fact that found? is 
set to false. Search starts 
searching at the insertion point. 
Use unselect to undo the 
highlighting effect of search.  

See also found?.  

Given that there is a text box 
containing some text on the page:  

to replaceall :this 
:bythat  
search :this  
if not found? [stop]  
insert :bythat  
replaceall :this 
:bythat  
end  

select  Tells MicroWorlds EX to start 
selecting text at the cursor position 
in the current text box. Any cursor 
motion (top, bottom, cu, cd, cf, 
and cb) will select text.  

Given that there is a text box 
containing some text on the page:  

top select bottom  

selected  Reports as a word a copy of the 
characters in the block of selected 
text in the active text box. If no 
block of characters is selected, 
selected reports the empty word. 
Use parse to convert the block of 
characters into a list.  

Given that there is a text box 
containing some text on the page:  

top select bottom  
make "selection 
selected  
show :selection  

The content of the text box is 
reprinted in the Command Center.  
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sender  Reports the name of the turtle who 
has made the last broadcast or 
tell. Sender must be used in the 
OnMessage field of a turtle's 
backpack.  

See tell, message and 
broadcast. See also Rules Tab - 
OnMessage in the section 
Fundamentals in the Help 
System.  

In the Onclick field of t1's 
backpack:  

broadcast "here  

In the OnMessage field of t2's 
backpack:  

towards sender  

Click on t1.  

sentence (se)  

word-or-list1  

word-or-list2  

(sentence  

word-or-list1  

word-or-list2  

word-or-list3..)  

Reports a list which is made up of 
its inputs (words or lists). 
Sentence can take more than 2 
inputs when sentence and the 
inputs are enclosed in 
parentheses.  

See list.  

Given that these turtles exist on 
the page:  

show se "Hello "there  
Hello there  

to middle  
t2, setpos sentence  
((t1's "xcor)+(t3's 
"xcor)) / 2  
((t1's "ycor)+(t3's 
"ycor)) / 2  
end  

set  

object  

property  

value  

Sets a property for an object to the 
specified value. The first input is 
the name of an object. The second 
input is a property name and the 
last one is the value.  

Project:  

presentationmode? showtoolbar? 
showcc? showtabs? 
showstatusbar? showtechniques?  

Page:  

transition  

Turtle:  

visible? frozen? menu, notes 
procedures onclick ontick 
ontouching onmessage onevent 
on? colorname  

Button:  

visible? pos size onclick on? 
frozen? visible?  

Given that these objects exist on 
the page:  

set "text1 "visible? 
"false  
set "t1 "onclick  
[once [seth random 360 
fd 50]]  
set "t1 "red  
[once [rt 180]]  
set "slider1 
"showname? "true  
set "brown "mouseclick  
[silly-sound]  
set "blue "onturtle  
[once [announce [You 
win!]]]  
set "announce "pos [0 
0]  
set "page1 "transition 
2  
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Slider:  

visible? pos showname? limits 
value frozen? vertical? visible?  

Text:  

text visible? transparent? 
showname? frozen? pos size 
visible? singleline?  

Public color detection:  

mouseclick, onturtle  

Hyperlinks:  

visible? pos showname? frozen? 
link  

Media Objects:  

visible? pos showname? frozen? 
on?  

Additional for Video:  

size  

Question and Announce:  

pos  

Choosers (round buttons sets, 
etc.):  

pos value visible? showname? 
frozen? labels (except for 
checkboxes)  

See get.  

setbg  

color-name-or-
number  

Stands for set background. Sets 
the background color for the page. 
The input can be the name of a 
color or a number. Use setbg 0 or 
setbg "white to reset the original 
background. You can't use setbg 
on a frozen background.  

See bg, fill, freezebg and 
unfreezebg.  

setbg 29  
repeat 10 [setbg bg - 
1]  
setbg "red  
setbg 0  
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setcell  

row-number  

column-number  

value  

Sets the value of the specified cell 
(in row-number, column-number) 
in the current Microsoft Excel 
worksheet. Note that the command 
openworksheet makes an Excel 
worksheet available to 
MicroWorlds EX.  

The Excel related primitives only 
work if you have this program 
available in your computer.  

See getcell and closeworksheet.  

Given that this worksheet exists:  

openworksheet "cards 
"sheet1  
setcell 1 1 50  
setcell 1 2 100  
setcell 1 3 
"|=AVERAGE(A1:B1)|  
show getcell 1 3  
75  

setcolor (setc)  

color-name-or-
number  

Sets the color of the turtle's pen. If 
the turtle has its original shape, it 
changes color to show the pen 
color. The input can be the name 
of a color or a number. The original 
pen color is black, or color number 
9. The input can be an integer, a 
fraction or a one place decimal.  

See color.  

Given that there is a turtle on the 
page:  

setc 45 fill  
setc "orange fill  

setfont  

word  

Sets the font for the selected text 
in the current text box. If no text is 
selected, setfont sets the cursor to 
use that font for typing. The input 
must be the name of a font in your 
system. If the name of the font has 
spaces, for example, Times New 
Roman, you must enclose the 
whole name in vertical bars. You 
can also set the text font by 
choosing Font from the Text menu. 

See settc, setfontsize, and 
setstyle.  

Given that there is a text box 
containing some text on the page:  

top select bottom  
setfont "arial  
setfont "|times new 
roman|  

setfontsize  

number  

Sets the font size for the selected 
text in the current text box. If no 
text is selected, setfontsize sets 
the cursor to use that font size for 
typing. You can also set the text 
size by choosing Font from the 
Text menu. We recommend using 
"True Type Fonts" (those with the 
symbol in the font dialog box). 
True type fonts allow many font 
sizes.  

See setfont, settc, and setstyle.  

Given that there is a text box 
containing some text on the page:  

top select bottom  
setfontsize fontsize + 
10  

setfooter  

word-or-list  

Sets the contents of the footer on 
printouts. Normally, the footer is 
empty. Use the empty list as input 
if you do not want any footer after 
using setfooter.  

setfooter [MicroWorlds 
Lovers, Grade 4]  
setfooter []  
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setheading 
(seth)  

number  

Sets the turtle's heading to the 
specified direction (in degrees). 
The degrees correspond to those 
of a compass: 0 degrees is due 
North, 90 is East, 180 is South, 
and 270 is West. Right and left 
turn a turtle a number of degrees 
from its current heading. Seth 
makes a turtle point to a specific 
direction, regardless of its previous 
heading.  

See heading, right and left.  

Given that there is a turtle on the 
page:  

seth 0  
seth 90  
rt 90  
seth 90  

setinstruction  

word-to-run  

 

setinstruction  

instruction-list  

Sets the instruction for the current 
turtle. This is equivalent to typing 
the instructions in the turtle's 
OnClick instruction field in its 
backpack. If the list includes the 
word forever or launch, the 
instruction's mode is set to Forever 
or Once, accordingly. If these 
words are not included, the mode 
is unchanged. If the turtle is 
running an instruction when 
setinstruction is used, the turtle 
will click off.  

See set and get  

Given that there is a turtle on the 
page:  

to turnoff  
setsh "off  
setinstruction "on  
end  

to turnon  
setsh "on  
setinstruction "off  
end  

setinstrument  

name-or-
number  

Sets the instrument for the next 
note command. There are 7 
instrument names: piano, 
harpsichord, vibraphone, guitar, 
violin, clarinet, and kalimba. You 
can also use any number from 1 to 
128. This setting is not saved with 
the project. If needed, put a 
setinstrument instruction in a 
startup procedure. See Startup.  

setinstrument "violin  
note 60 10  

setopacity  

number  

Sets the opacity of the turtle and 
its pen. The input must be between 
0 and 100 and represents a 
percentage.  

See opacity.  

Given that there is a turtle on the 
page:  

pd setpensize 30  
setopacity 72  
repeat 36 [fd 10 rt 10  
setopacity opacity - 
2]  
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setpensize  

number  

Sets the turtle's pen size which 
determines the thickness of the 
lines it will draw. The pen size can 
also be set by picking a brush 
shape and the pencil in the 
Painting/Clipart palette and clicking 
on a turtle with the Pencil tool. 
(The pen size is the diameter of 
the brush.) The original pen size is 
1. The maximum pen size is 30.  

See pensize.  

Given that there is a turtle on the 
page:  

pd setpensize 30  
repeat 29  
[fd 1 setpensize 
pensize - 1]  

setpos  

[x y]  

Stands for set position. Moves the 
turtle to the designated x y 
coordinates. The center point of 
the page is [0 0]. The maximum 
number for x and y is 9999.  

See pos and Private and Public 
Color Detection in the section 
Fundamentals in the Help 
System.  

Given that there is a turtle on the 
page:  

setpos [0 0]  
setpos [-50 50]  

setrotate  

list-of-turtle-
numbers-or-
names  

Sets an animation mode based on 
the turtle's heading. The range of 
possible headings (360 degrees) is 
divided by the number of shapes in 
the list and the turtle uses the 
appropriate shape. If there are 4 
shapes in the list, the turtle uses 
the first shape for a heading of -45 
to 44, the second shape for 45 to 
134, and so on. This mode can 
also be set in the turtle's backpack, 
in the State tab.  

See shape and setshape, and 
Animation - Changing Shapes 
Based on Heading in the section 
Fundamentals in the Help System 

 

 

 

 

 

 

 

.  

Given that there is a turtle on the 
page and these shapes names 
and numbers are defined:  

setrotate  
[north south east 
west]  
repeat 360 [rt 1]  
setrotate [1 2 3 4 5 6 
7 8]  
repeat 360 [rt 1]  
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setshape 
(setsh)  

shape-name-or-
number  

 

setshape 
(setsh)  

list-of-names-or-
numbers  

Gives a shape or a set of shapes 
to the turtle. Setshape also resets 
the animation mode to Setshape if 
it was set to Setrotate. The 
maximum number for setshape is 
128. When a list of shape names 
or numbers is given as input, each 
forward and back command 
makes the turtle cycle through the 
list of shapes. The shape can also 
be set by selecting one or several 
shapes from the Painting/Clipart 
palette and clicking on a turtle.  

See setrotate, shape, and 
Animation - Changing Shapes... 
in the section Fundamentals in 
the Help System.  

Given that there is a turtle on the 
page:  

setsh 1  
setsh "cat  
setsh [1 2 3]  
setsh [cat1 cat2 cat3]  
glide 50 0.1  

setsize  

number  

Sets the size of the turtle. The 
original size is 40 and the 
minimum and maximum sizes are 
5 and 160, respectively. Turtle 
shapes look nice when they are 
multiples of 20. You can also 
change the size of the turtle with 
the magnifiers.  

See size.  

Given that there is a turtle on the 
page:  

setsize 15  
repeat 12  
[setsize size + 5 wait 
5]  

setstyle  

word-or-list  

Sets the font style for the selected 
text in the current text box. If no 
text is selected, setstyle sets the 
cursor to use that style for typing. 
The input must be the name of a 
style (regular, bold, italic, 
underline). Multiple styles can be 
applied by inserting styles in a list. 
You can also set the text style by 
choosing Font from the Text menu. 

See setfont, setfontsize, and 
settc.  

Given that there is a text box 
containing some text on the page:  

top select bottom  
setstyle "italic  
setstyle [bold italic]  

settc  

color-name-or-
number  

Stands for set text color. Sets the 
color for the selected text in the 
current text box. If no text is 
selected, settc sets the cursor to 
use that color for typing. The input 
can be the name of a color or a 
number. The original text color is 
black, or color number 9. You can 
also set the text color by choosing 
Color in the Text menu.  

See setfont, setfontsize, and 
setstyle.  

Given that there is a text box 
containing some text on the page:  

settc "violet insert 
"w  
settc "15 insert "o  
settc "orange insert 
"w  
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setx  

number  

Sets the x coordinate of the current 
turtle. The y coordinate remains 
unchanged.  

Given that there is a turtle on the 
page:  

setx 100  
setx 0  

sety  

number  

Sets the y coordinate of the current 
turtle. The x coordinate remains 
unchanged.  

Given that there is a turtle on the 
page:  

sety 100  
sety 0  

shape  Reports the shape name or 
number, or the list of shape names 
or numbers of the current turtle.  

See setshape.  

Given that there is a turtle on the 
page:  

repeat 4 [setsh shape 
+ 1]  

show  

word-or-list  

Prints a word or a list in the 
Command Center. The outer level 
of brackets in a list are not shown.  

Given that t1 exists on the page:  

show "hello  
hello  
show [hello there]  
hello there  
show pos  
0 0  

showtext  Makes the current text box visible.  

See hidetext.  

Given that there is a text box 
containing some text on the page:  

hidetext  
wait 20  
showtext  

sin  

number  

Stands for sine. Reports the sine 
of number degrees.  

See cos and tan.  

Given that a turtle exists on the 
page. The result is just an 
example.  

show sin 45  
0,707106781187  
show sin heading  
-0.866025403784  

size  Reports the size of the current 
turtle.  

See setsize and Changing the 
Turtle's Size in the section 
Fundamentals in the Help 
System.  

Given that there is a turtle on the 
page:  

setsize 15  
repeat 12  
[setsize size + 5 wait 
5]  
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snaparea  

shape-number  

[x y]  

[xsize ysize]  

Copies the graphics in the defined 
area and pastes it in a shape spot 
in the public Shapes Tab. [x y] is 
the top left starting point, and 
[xsize ysize] determines the size 
of the rectangle that is copied into 
the shape. To find out the values 
you need for the position and size, 
drag a region on the page and look 
for the x, y, xsize and ysize values 
in the Status bar.  

See snapshape and Copying 
Background Graphics into a 
Shape in the section 
Fundamentals in the Help 
System.  

 

 

 

Draw a complex background and 
look at the public Shapes Tab for 
the effect of this command:  

snaparea 1 [0 0] [50 
60]  

snapshape  Copies the page graphics (not the 
wallpaper) behind the turtle into 
the current shape of the turtle. You 
cannot use snapshape if the turtle 
has its original turtle shape. The 
turtle must be completely visible on 
the page. Snapshape resets the 
turtle's size to 40 (its original size) 
even if the size has been changed. 

If you want to copy the shape into 
an empty spot in the public Shapes 
Tab, set the turtle to this shape 
before using snapshape.  

See snaparea and Copying 
Background Graphics into a 
Shape in the section 
Fundamentals in the Help 
System.  

Given that there is a turtle on the 
page, NOT wearing the default 
turtle shape. Draw a complex 
background and look at the public 
Shapes Tab for the effect of this 
command:  

pd rt 11 fd 9999  
setsh 5  
snapshape  
cg  
pu fd 50  

snapshot  Takes a snapshot of the 
background. The next time a 
restore command is used, the 
background will be restored to 
what it was at the moment the 
snapshot was taken. Note that 
there is only one snapshot per 
project, and the snapshot is not 
saved with the project.  

See restore, freezebg and 
unfreezebg.  

Given that there is a turtle on the 
page:  

pd lt 11 fd 9999  
snapshot  
rt 22 fd 9999  
restore  
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sol  Stands for start of line. Brings the 
cursor (insertion point) in the 
current text box to the beginning of 
the current logical line. Try using 
this command in a button so that 
you can see the effect on the 
cursor.  

See eol.  

Given that there is a text box 
containing some text on the page:  

sol delete insert "I  

space  Reports the amount of free 
MicroWorlds EX space in bytes.  

See recycle.  

show space recycle 
show space  

sqrt  

number  

Stands for square root. Reports 
the square root of its input.  

show sqrt 100  
10  

st  Stands for show turtle. Shows the 
current turtle.  

See ht.  

Given that there is a turtle on the 
page:  

t1, repeat 5 [ht wait 
5 st]  

stamp  Stamps a copy of the turtle on the 
background. The pen does not 
have to be down to stamp. You 
can also use the Stamper tool in 
the Toolbar to stamp the turtle's 
shape.  

See Stamping a Turtle in the 
section Fundamentals in the Help 
System.  

Given that there is a turtle on the 
page:  

repeat 10 [stamp fd 
40]  

stamptext  

text-box-name  

Leaves a copy of the designated 
transparent text box on the 
background. This is equivalent to 
using the Stamper tool on a 
transparent text box. See 
transparent.  

Given that text1 exists on the 
page and it contains some text:  

transparent "text1  
stamptext "text1  

Drag the text box away.  

startup  Startup is a special name for a 
public procedure. If your project 
has a procedure named startup, 
this startup procedure is executed 
automatically when you open the 
project. Use this feature to setup 
your project: display the right page 
and start the presentation mode for 
example.  

Given that there is such a page in 
the project. Save the project with 
a different page showing, close 
and reopen the project.  

to startup  
intropage  
presentationmode  
end  
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stop  Stops the procedure that is 
running. Stop can only be used in 
a procedure.  

See stopall, stopme, and output.  

Given that there is text box on the 
page:  

to countup :number  
if :number > 100 
[stop]  
print :number  
countup :number + 5  
end  

stopall  Stops all running procedures and 
processes, including turtles and 
buttons. Stopall can be used as a 
button, from the Command Center, 
or in a stop rule in a procedure. 
This primitive sets the Stop All 
button in the Toolbar. All the 
processes are stopped, and the 
OnTick processes are paused. The 
OnTick processes resume 
immediately when a new process 
is launched.  

See stop and stopme.  

 

 

Given that there are several 
turtles running towards a red area:  

to race  
everyone [if 15 = 
colorunder  
[announce se who "wins  
stopall]]  
end  

stopme  Stops the process in which this 
command was run. Stopme 
cannot be used to stop a turtle 
inside a color instruction. In this 
case, use clickoff instead.  

See stop and stopall.  

Given that these turtles exist on 
the page and that they are close 
to one another:  

t1, forever [fd 1 if 
(distance "t2) > 150 
[stopme]]  

sum  

number1  

number2  

 

(sum  

number1  

number2  

number3...)  

Reports the sum of its inputs. If 
more than two inputs are used, 
sum and its inputs must be 
enclosed in parentheses.  

See +.  

Given that a turtle exists on the 
page. The result is just an 
example.  

show sum 10 10  
20  
show sum xcor ycor  
212  
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T 
 

Primitive  

Input(s)  

Description  Examples  

 
talkto (tto)  

turtle-name  

 

talkto (tto)  

text-box-name  

 

talkto (tto)  

list-of-names  

Makes the turtle(s) or text box 
current. This command has the 
same effect as typing the name of 
a turtle or text box followed by a 
comma. This is the only way of 
making many turtles do the same 
thing at the same time.  

See ask, and Processes and 
Who in the section More 
Techniques in the Help System.  

Given that there are three turtles 
on the page:  

tto [t1 t2 t3]  
repeat 7 [fd 10 wait 
1]  

tan  

number  

Stands for tangent. Reports the 
tangent of its input.  

See sin and cos.  

Given that a turtle exists on the 
page. The result is just an 
example.  

show tan heading  
-1.73205080757  

tc  Stands for text color. Reports the 
number of the text color used in 
the current text box at the insertion 
point. If text that has more than 
one color is selected, tc reports 
the color of the last character that 
has been selected.  

See settc.  

 

 

 

 

 

 

Given that text1 exists on the 
page.  

to rainbow  
settc "violet pr tc  
settc " red pr tc  
settc " orange pr tc  
end  
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tell  

turtle-name  

word-or-list  

 

tell  

list-of-turtle-
names  

word-or-list  

 

Sends a message for the turtle or 
turtles named as input to hear. Tell 
triggers the instruction found in the 
OnMessage field in the Rules Tab 
of the specified turtle's or turtles' 
backpack(s).  

See broadcast, message and 
sender. See also Rules Tab - 
OnMessage in the section 
Fundamentals in the Help 
System.  

In the Onclick field of t1's 
backpack:  

tell "t2 "here  

In the OnMessage field of t2's 
backpack:  

towards sender  

Click on t1.  

textcount  

text-box-name  

Reports the number of lines in the 
named text box. Lines are 
delimited by carriage returns and 
line feed sequences (they are 
logical lines, not physical lines). 
Empty lines are taken into account. 
The number that textcount reports 
is the maximum number that can 
be used with textitem.  

See textpick, count, and 
Programming With Texts in the 
Programing section in the Help 
System.  

Given that text1 exists on the 
page and it contains some text. 
The result is just an example.  

show textcount "text1  
33  

textitem  

line-number  

text-box-name  

Reports the designated "line" of 
the named text box. Lines are 
delimited by carriage returns and 
line feed sequences (they are 
logical lines, not physical lines). 
Empty lines are taken into account. 
The first input must be between 1 
and the number of lines in the text 
box. The line reported by textitem 
is a long word (a sequence of 
characters including spaces). Use 
parse to turn a long word into a 
list.  

See textpick, textcount, and 
Programming With Texts in the 
Programing section in the Help 
System. 

 

  

Given that text1 exists on the 
page and it contains some text. 
The result is just an example.  

show textitem 2 "text1  
This is the second 
line  
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textlist  Reports a list containing the 
names of text files in the current 
directory. Only text type files 
(extensions txt or rtf) are shown.  

See files, projectlist, and pictlist. 

The result is just an example.  

show textlist  
mytext.txt 
listoffriends.rtf  

textpick  

text-box-name  

Reports the text of a randomly-
chosen line from the named text 
box. Lines are delimited by 
carriage returns and line feed 
sequences (they are logical lines, 
not physical lines). Textpick can 
pick empty lines. The line reported 
by textpick is a long word (a 
character string including spaces). 
Use parse to turn a long word into 
a list.  

See textitem, textcount, and 
Programming With Texts in the 
Programing section in the Help 
System.  

Given that text1 and text2 exists 
on the page and text1 contains 
some text. One of the lines of 
text1 is printed in text2.  

settext2 textpick 
"text1  

textwho  Reports the name of the current 
text box. You can change the 
current text box using the text box 
name followed by a comma or with 
talkto.  

Given that text1 exists on the 
page and it contains some text. 
The result is just an example.  

show textwho  
text1  
if textwho = "text1 
[ct]  

thing  

name  

Reports the value of the named 
variable. Corresponds to the use of 
a colon ( : ) preceding a word.  

See make and name. See also 
Global Variables in the section 
Programming in the Help System. 

Define this procedure. Run the 
other instructions in the Command 
Center.  

to translate :word  
if name? :word  
[op thing :word]  
op "Unknown  
end  

make "table "mesa  
make "house "casa  
show translate "table  
mesa  
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timer  Reports a number representing the 
time elapsed since MicroWorlds 
EX started, or since the last reset 
command was run. The number is 
in tenths of a second.  

See reset.  

Define this procedure and run the 
other instructions in the Command 
Center.  

to reflex  
resett  
setnum1 1 + random 10  
setnum2 1 + random 10  
question  
(se [What is] num1  
   "times num2 [?])  
ifelse answer = num1 * 
num2  
   [announce se timer 
/ 10 "sec]  
   [announce [Wrong 
answer]]  
end  

createprojectvar "num1  
createprojectvar "num2  
reflex  

top  Moves the cursor (insertion point) 
to the beginning of the text in the 
current text box. Try using this 
command in a button so that you 
can see the effect on the cursor. 
See bottom.  

 

Given that there is a text box on 
the page:  

pr "there! top print 
"Hello  

touchedturtle 
(tturtle)  

Reports the name of the turtle that 
is touched by the one running this 
command. Touchedturtle can 
only be used inside the 
OnTouching field of a turtle's 
backpack.  

See touching? and Rules Tab - 
OnTouching in the section 
Fundamentals in the Help 
System.  

In the Onclick field of t1's 
backpack:  

towards "t2 glide 9999 
1  

In the OnTouching field of t1's 
backpack:  

if touchedturtle = "t2  
[lt 90]  

Click on t1.  
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touching?  

turtle-name  

turtle-name  

Reports true if the two turtles are 
touching each other; reports false 
if they are not touching. 
Touching? always reports false if 
one of the turtles is hidden.  

See touchedturtle and Rules Tab 
- OnTouching in the section 
Fundamentals in the Help 
System.  

Given that t1 and t2 exist on the 
page:  

to meet  
t1,  
forever [wander]  
waituntil [touching? 
" t1 " t2]  
cancel [wander]  
end  

to wander  
seth random 360 glide 
100 1  
end  

towards  

turtle-name  

Sets the heading of the current 
turtle to aim towards the turtle 
whose name is given as input.  

See distance and seth.  

Given that t1 and t2 exist on the 
page:  

to go  
t1,  
forever [fd 1 check]  
end  

to check  
if 30 < distance "t2  
[towards "t2]  
end  

transparent  

text-box-name  

Makes the designated text box 
transparent. This is equivalent to 
selecting Transparent in the text 
box's right-click menu, on the page 
or in the Project Tab. An empty 
text box cannot be made 
transparent.  

See opaque.  

 

 

 

 

 

 

 

Given that text1 exists on the 
page and it contains some text:  

transparent " text1  
opaque " text1  
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turtlesown  

word  

Assigns a state variable to all the 
turtles in the current project. This 
variable can then be set to a 
specific value for each turtle. This 
command creates a command-
reporter pair of primitives that can 
be used in the current project only: 
the word set followed by the name 
of the variable (for example, 
turtlesown "speed creates a 
setspeed command) and the 
name of the variable (in this 
example, speed).  

The State Tab of the turtle's 
backpack displays the turtlesown 
variables. The value of the variable 
can also be set by double-clicking 
on the variable name in the turtle's 
backpack.  

After a turtlesown instruction, the 
value of the variable is empty until 
it is set.  

See giveturtle and State 
Variables in the section 
Programming in the Help System. 

Given that these turtles exist on 
the page:  

turtlesown "start  
t1, setstart [-50 -51]  
t2, setstart [-30 -51]  
everyone [setpos 
start]  
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U  
 

Primitive  

Input(s)  

Description  Examples  

 
unfreeze  

object-name  

 

unfreeze  

list-of-names  

 

unfreeze  

page-name  

Unfreezes the button, text box, 
turtle, slider, or any object on a 
page, so they can be changed using 
the mouse. A page name can also 
be used as input to unfreeze all the 
elements contained on that page. 
This command corresponds to the 
Unfreeze menu item accessible by 
right-clicking on object icons 
(previously frozen) in the Project 
Tab area. The eye tool can be used 
to move frozen objects.  

See freeze, freezebg and 
unfreezebg. See also Freezing 
Objects in the section 
Fundamentals in the Help System.  

Given that these objects exist on 
the page:  

unfreeze "t1  
unfreeze [button1 
text1]  
unfreeze " page1  

unfreezebg  Stands for unfreeze background. 
Unfreezes the background that was 
frozen by freezebg. When you click 
on the page icon in the Project Tab, 
a message appears in the Status 
Bar if the background is frozen.  

See freezebg, shapshot and 
restore.  

Given that there is a turtle on the 
page:  

to go  
setc "orange  
pd rt 11 fd 9999 wait 
15  
freezebg  
setc "yellow  
rt 11 fd 9999 wait 15  
cg wait 15  
unfreezebg  
cg  
end  

unselect  Undoes the highlighting effect of 
select or search.  

Given that there is a text box on 
the page and it contains some 
text:  

top select bottom  
setfont "|Comic Sans 
MS| unselect  
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W 
 

Primitive  

Input(s)  

Description  Examples  

 
wait  

duration  

Causes a pause in the execution of 
a program or instruction. Duration is 
measured in 10ths of a second.  

Given that there is a turtle on the 
page:  

forever [fd 1 wait 1]  

waituntil  

true-or-false-
list-to-run  

Tells MicroWorlds EX to wait until 
true-or-false-instruction-list is true 
before running another instruction. 
The input must be an instruction list 
that reports either true or false 
when it is run.  

See done?.  

Given that these turtles exist on 
the page:  

waituntil [touching? 
"t1 "t2]  

wallpaper  Displays the Wallpaper page. See 
The Wallpaper in the section 
Fundamentals in the Help System.  

Given that page1 exists in the 
project:  

wallpaper pd fd 100 
page1 cg  

when  

true-or-false-  

instruction-list  

instruction-list  

Starts an independent parallel 
process that repeatedly tests 
whether the first instruction list 
reports true or false. If it reports 
true, the second instruction list is 
run. To stop a when instruction, use 
cancel (only on the true-or-false-
instruction-list), Stop All, or press 
Ctrl+Break.  

Note: we strongly recommend using 
the Turtle events in backpack (When 
this - Do that) instead of this 
command.  

See Stopping Processes in the 
section More Techniques in the 
Help System.  

Given that there is a turtle on the 
page:  

when [ycor > 0] [bk 
40]  

who  Reports the name of the current 
turtle.  

See ask, listen, talkto, and 
Processes and Who in the section 
More Techniques in the Help 
System.  

 

Given that there are many turtles 
on the page:  

everyone  
[fd 20 * butfirst who]  
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word  

word-or-list1  

word-or-list2  

 

(word  

word-or-list1  

word-or-list2  

word-or-list3...)  

Combines its inputs into one word 
and reports the word. Word can be 
used to make a list into a word. 
Word can take one input or more 
than 2 inputs when word and the 
inputs are enclosed in parentheses.  

See list and word?.  

Given that there is a text box on 
the page:  

to oneup :word  
print sentence [You 
may be] :word  
print sentence  
[But I am]  
word butlast :word 
"ier  
end  

Try:  
oneup "happy  

word?  

word-or-list  

Reports true if the input is a word.  

See number? and list?  

show word? "hello  
true  
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X 
 

Primitive  

Input(s)  

Description  Examples  

 
xcor  Stands for x coordinate. Reports the 

x coordinate of the current turtle.  

See pos, setx and ycor.  

Given that there is a turtle on the 
page:  

repeat 360 [setx xcor 
+ 5 sety 100 * sin 
xcor]  
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Y 
 

Primitive  

Input(s)  

Description  Examples  

 
ycor  Stands for y coordinate. Reports the 

y coordinate of the current turtle.  

See pos, sety, and xcor.  

Given that there is a turtle on the 
page:  

repeat 360 [sety ycor 
+ 5 setx 100 * sin 
ycor]  
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Conceptual Listing 
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Turtles and Graphics 
 

Primitive  

Input(s)  

Description  Examples  

ask  

turtle-or-text-
name  

instruction-list  

 

ask  

list-of-names  

instruction-list  

Temporarily tells each element in the first 
input to run the instruction list. The first 
input can be the name(s) of one or many 
turtles or text boxes. Ask does not change 
the current turtle or text box. The 
apostrophe can be used to ask a turtle to 
report something. See also talkto.  

Given that t1 and t2 have OnClick 
instructions, and text1 exists on the 
page:  

ask [t1 t2] [clickon]  
ask "text1 [cleartext]  
t2, setpos ask "t1 [pos] 
t2, setpos t1's "pos  

back (bk)  

number  

Moves the turtle backwards. See also 
forward.  

Given that there is a turtle on the 
page:  

pd repeat 4 [bk 50 lt 
90]  

bg  Stands for background. Reports a 
number representing the color of the 
background. The background color is 0 
(white) when MicroWorlds EX starts up  

repeat 140 [setbg bg + 
1] 
setbg 0  

broadcast  

word-or-list  

Sends a message for all the turtles on the 
current page to hear. Broadcast triggers 
the instruction found in the OnMessage 
field in the Rules Tab of the turtle's 
backpack. If there is no instruction in a 
turtle's OnMessage field, the broadcasted 
message is ignored.  

See tell, message and sender. See also 
Rules Tab - OnMessage in the section 
Fundamentals in the Help System.  

In the Onclick field of t1's backpack:  

broadcast "here  

In the OnMessage field of t2's 
backpack:  

towards sender  

Click on t1  

cg  Stands for clear graphics. Clears the 
graphics on the page and returns the 
current turtle to its home position, pointing 
up. See also clean.  

Given that there is a turtle on the 
page:  

pd fd 50  
cg 
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clean  Clears the graphics without changing any 
turtle's position.  

See also cg.  

Given that there is a turtle on the 
page.  

pd fd 50  
clean  

clickon  Simulates a mouse click on the current 
turtle, turning it on if it was off. This 
command has an effect only if the turtle 
has an OnClick instruction.  

See clickon, listen, and Rules Tab - 
Clickon in the section Fundamentals in 
the Help System.  

Given that there are turtles with 
OnClick instructions on the page:  

t1, clickon wait 30 
clickoff  
everyone [clickon]  

clickoff  Simulates a mouse click on the current 
turtle, turning it off if it was on. This 
command has an effect only if the turtle is 
running its OnClick instruction.  

See clickoff, listen, and Rules Tab - 
Clickon in the section Fundamentals in 
the Help System.  

Given that there are turtles with 
OnClick instructions on the page:  

t1, clickon wait 30 
clickoff  
everyone [clickoff]  

clone  

turtle-name  

Creates a copy of the named turtle. The 
new turtle takes the first available name 
on the current page (t followed by a 
number). Except for the name and 
position, the new turtle is a perfect clone 
of the original (backpack contents).  

Given that t1 exists on the page:  

clone "t1  

color  Reports the turtle's color as a number. 
Color reports a number, even if a name 
was used as input for setc.  

See also setc.  

Given that there's a turtle on the 
page:  

show color  
9  
repeat 140 [setc color + 
1]  

colorunder  Reports the color under the center point 
of the current turtle as a number. 
Colorunder reports the color number if 
the color's on the background, on a 
drawing or stamped shape on the current 
page or on the Wallpaper.  

See also Private and Public Color 
Detection in the section Fundamentals 
in the Help System.  

 

 

 

Given that there's a turtle on the 
page. Place a turtle over a red 
drawing.  

if colorunder = 15  
[seth 1 fd 15]  
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distance  

turtle-name  

Reports the distance between the current 
turtle and the turtle indicated.  

See towards.  

Given that there are two turtles on 
the page, t1 and t2. Select Animate 
in each turtle's right-click menu..  

t1, forever [if 50 < 
distance "t2  
[towards "t2]]  

Note:  

if 50 < distance "t2  

is equivalent to:  

if (distance "t2) > 50  

The parentheses are required in the 
second case because otherwise, 
MicroWorlds compares t2 and 50 
instead of comparing (distance "t2) 
and 50.  

exportturtle  

pathname  

Saves the current turtle on disk. The turtle 
file contains the turtle and all the contents 
of its backpack. If the pathname is just a 
word, the turtle is saved in the current 
directory with the extension mwa. An 
exported turtle can be imported or 
dragged into a different project, or 
emailed.  

See importturtle.  

Given that there is a turtle on the 
page:  

exportturtle "model  

everyone  

instruction-list  

Makes all the turtles on the current page 
run the instruction, one after the other.  

See ask and talkto.  

Given that there are a few turtles on 
the page:  

everyone [glide -80 2]  

fill  Fills a closed area with the turtle's pen 
color. If the area is not perfectly closed, 
the paint "leaks" onto the entire page. Fill 
works regardless of the turtle's pen state 
(up or down).  

See setc.  

Given that there is a turtle on the 
page:  

pd  
repeat 4 [fd 50 rt 90]  
rt 45 pu fd 5  
setc "yellow  
fill  

forward (fd)  

number  

Moves the turtle forward.  

See back.  

Given that there is a turtle on the 
page:  

pd  
repeat 4 [fd 50 rt 90 
wait 2]  
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freezebg  Stands for freeze background. Freezes 
the background graphics in their current 
state. You can still draw over the 
background and erase the new drawings, 
but the original background (before 
freezing) won't be erased.  

See unfreezebg, snapshot and restore.  

Given that there is a turtle on the 
page:  

pd fd 50  
freezebg  
repeat 45 [fd 40 rt 3]  
cg  

giveturtle  

word  

Assigns a state variable to the current 
turtle and creates a command-reporter 
pair of primitives that can be used in the 
current project only: the word set followed 
by the name of the variable (for example, 
giveturtle "speed creates a setspeed 
command) and the name of the variable 
(in this example, the reporter speed).  

The State Tab of the turtle's backpack 
displays the giveturtle variables. The 
value of the variable can also be set by 
double-clicking on the variable name in 
the turtle's backpack.  

After a giveturtle instruction, the value of 
the variable is empty until it is set.  

See turtlesown and State Variables in 
the section Programming in the Help 
System.  

Given that there is a turtle on the 
page, you can give it a "personal" 
home position:  

giveturtle "homepos  
sethomepos [50 50]  
fd 50  
setpos homepos  
home  
setpos homepos  

glide  

distance  

speed  

Makes the turtle glide over the distance 
indicated. The second input sets the 
turtle's gliding speed. The maximum 
distance and maximum speed for glide 
are 9999 and 99, respectively.  

Given that there is a turtle on the 
page:  

glide 50 1  
glide 100 0.1  

heading  Reports the current turtle's heading in 
degrees. The degrees correspond to 
those of a compass; 0 degrees is due 
North, 90 is East, 180 is South, and 270 
is West.  

See seth, right, left.  

Given that there is a turtle on the 
page. Your result will differ:  

seth random 360  
show heading  
33  

home  Moves the turtle to the center of the page 
coordinates [0 0], pointing up.  

See setpos.  

Given that there is a turtle on the 
page:  

home pd  
repeat 50 [home  
setpos se random 100  
random 100]  
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ht 

 

Stands for hide turtle. Hides the current 
turtle.  

See st.  

Given that there is a turtle on the 
page:  

glide 60 2  
ht fd 50 st  
glide 60 2  

importturtle  

pathname  

Imports the turtle file on the current page. 
The turtle file contains all the 
characteristics of the turtle (the contents 
of its backpack). A turtle file is created by 
the command exportturtle, or by the 
options Export and Mail it in the turtle's 
right-click menu.  

See exportturtle and Exporting, 
Importing and Mailing Turtles in the 
section Fundamentals in the Help 
System.  

Given that such a file exists in the 
current directory:  

importturtle "model  

inback  Puts the current turtle behind all the other 
turtles on the page. A newly created turtle 
is always in front of the others.  

See infront.  

Given that t1 is facing t2, less than 
100 steps away:  

t1, setc "red  
infront  
glide 100 0.1  
inback  
glide -100 0.1  

infront  Brings the current turtle in front of all the 
other turtles on the page. A newly created 
turtle is always in front of the others.  

See inback.  

Given that t1 is facing t2, less than 
100 steps away:  

t1, setc "red  
infront  
glide 100 0.1  
inback  
glide -100 0.1  

left (lt)  

number  

Turns the turtle to the left. The maximum 
value for number is 9999.  

See right and seth.  

Given that there is a turtle on the 
page:  

seth 0  
lt 90  
seth 90  
repeat 5 [fd 50 lt 144]  

listen  Sets the global "turtle who" (the turtle 
obeying instructions from the Command 
Center). This command allows you to 
change the global "turtle who" within a 
process that has been launched (for 
example, from a button).  

See Process and Who in the section 
More Techniques in the Help System. 
See also talkto and ask.  

Given that t1 and t2 exist on the page 
and that there is a button having t1, 
listen in its OnClick instruction.  

t2, clickon  
fd 30  
Click on the button  
fd 30  
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loadshape  

pathname  

shape-number  

Loads the specified picture file into the 
specified shape spot in the Public Shapes 
Tab. The picture file name will become 
the name of the shape if there is no other 
shape with that name in that Tab.  

The file must be the name of a picture file 
that MicroWorlds supports in the current 
directory or a full or relative path. The 
shape-number can be any number from 1 
to 128.  

See saveshape and Importing and 
Exporting Pictures in the section 
Fundamentals in the Help System.  

Given that there is a turtle on the 
page and that these files exists:  

loadshape "volcano 20  

Loads the volcano picture into shape 
20. The shape will be named 
volcano.  

loadshape 
"c:\picts\volcano.gif 20  

message  Reports the contents of the last message 
send by broadcast or tell. Message 
must be used in the OnMessage field of a 
turtle's backpack.  

See tell, broadcast and sender. See 
also Rules Tab - OnMessage in the 
section Fundamentals in the Help 
System.  

When you click on t1, t2 goes at 
position [100 100]:  

In the Onclick field of t1's backpack:  

broadcast [100 100]  

In the OnMessage field of t2's 
backpack:  

setpos message  

Click on t1  

newturtle  

word  

Creates a new turtle with the name 
indicated. The new turtle appears at the 
position [0 0] and is hidden. Use st to 
make it visible. Newturtle makes the 
turtle that is created the current turtle.  

Given that there is not a turtle with 
that name on the page:  

to create  
newturtle "newborn  
setx 30 st  
end  

opacity  Returns the opacity of the current turtle's 
pen and shape. The value is a 
percentage.  

See setopacity.  

Given that there is a turtle on the 
page:  

pd setpensize 30  
setopacity 72  
repeat 36 [fd 10 rt 10  
setopacity opacity - 2]  

pd  Stands for pen down. Puts down the pen 
of the current turtle. The turtle then leaves 
a trace when it moves, but not when it is 
dragged.  

See pu and pe.  

 

Given that there is a turtle on the 
page:  

repeat 6 [pu fd 10 pd fd 
10]  
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pe 

 

Stands for pen erase. Puts down the 
eraser of the current turtle. The turtle 
erases the graphics when it moves.  

See pd and pu.  

Given that there is a turtle on the 
page:  

setc "red fill  
pe  

repeat 5 [fd 50 rt 144]  

pensize  Reports a number representing the pen 
size of the current turtle. The original pen 
size is 1. The maximum is 30.  

See setpensize.  

Given that there is a turtle on the 
page:  

pd setpensize 30  
repeat 29  
[fd 1 setpensize pensize 
- 1]  

pos  Stands for position. Reports the position 
of the turtle as a list of two numbers (co-
ordinates). [0 0] is the position at the 
center of the page.  

See setpos.  

Given that there is a turtle on the 
page:  

show pos  
t1, setpos t2's "pos  

pu  Stands for pen up. Lifts up the pen of the 
current turtle. The turtle will not leave a 
trace when it moves.  

See pd and pe.  

Given that there is a turtle on the 
page:  

repeat 6 [pu fd 10 pd fd 
10]  

restore  Restores the background to the way it 
was the last time a snapshot command 
was issued. The turtle's position does not 
change. Everything else remains intact. 
See snapshot, freezebg and 
unfreezebg.  

Given that there is a turtle on the 
page:  

pd lt 11 fd 9999  
snapshot  
rt 22 fd 9999  
restore  

right (rt)  

number  

Turns the turtle to the right. The maximum 
value for number is 9999.  

See left and seth.  

Given that there is a turtle on the 
page:  

seth 0  
seth 90  
rt 90  
repeat 5 [fd 50 rt 144]  

saveshape  

pathname  

number  

Saves the specified shape (located in the 
public Shapes Tab) as a picture file. Use 
a simple file name to save the file in the 
current directory or full or relative 
pathname to save the file in a different 
directory.  

If the file name has no extension, the 
resulting file is a bmp image. Add a jpg, 
gif or png extension to the file name to get 
a specific file format.  

Given that there is a shape in spot 1 
of the public Shapes Tab:  

saveshape "moon 1  
saveshape "moon.jpg 1  
saveshape 
"c:\graph\moon.jpg 1  
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sender  Reports the name of the turtle who has 
made the last broadcast or tell. Sender 
must be used in the OnMessage field of a 
turtle's backpack.  

See tell, message and broadcast. See 
also Rules Tab - OnMessage in the 
section Fundamentals in the Help 
System.  

In the Onclick field of t1's backpack:  

broadcast "here  

In the OnMessage field of t2's 
backpack:  

towards sender  

Click on t1.  

setbg  

color-name-or-
number  

Stands for set background. Sets the 
background color for the page. The input 
can be the name of a color or a number. 
Use setbg 0 or setbg "white to reset the 
original background. You can't use setbg 
on a frozen background.  

See bg, fill, freezebg and unfreezebg.  

setbg 29  
repeat 10 [setbg bg - 1] 
setbg "red  
setbg 0  

setcolor (setc)  

color-name-or-
number  

Sets the color of the turtle's pen. If the 
turtle has its original shape, it changes 
color to show the pen color. The input can 
be the name of a color or a number. The 
original pen color is black, or color 
number 9. The input can be an integer, a 
fraction or a one place decimal.  

See color.  

Given that there is a turtle on the 
page:  

setc 45 fill  
setc "orange fill  

setheading 
(seth)  

number  

Sets the turtle's heading to the specified 
direction (in degrees). The degrees 
correspond to those of a compass: 0 
degrees is due North, 90 is East, 180 is 
South, and 270 is West. Right and left 
turn a turtle a number of degrees from its 
current heading. Seth makes a turtle 
point to a specific direction, regardless of 
its previous heading.  

See heading, right and left.  

Given that there is a turtle on the 
page:  

seth 0  
seth 90  
rt 90  
seth 90  

setopacity  

number  

Sets the opacity of the turtle and its pen. 
The input must be between 0 and 100 
and represents a percentage.  

See opacity.  

Given that there is a turtle on the 
page:  

pd setpensize 30  
setopacity 72  
repeat 36 [fd 10 rt 10  
setopacity opacity - 2]  
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setpensize  

number  

Sets the turtle's pen size which 
determines the thickness of the lines it will 
draw. The pen size can also be set by 
picking a brush shape and the pencil in 
the Painting/Clipart palette and clicking on 
a turtle with the Pencil tool. (The pen size 
is the diameter of the brush.) The original 
pen size is 1. The maximum pen size is 
30.  

See pensize.  

Given that there is a turtle on the 
page:  

pd setpensize 30  
repeat 29  
[fd 1 setpensize pensize 
- 1]  

setpos  

[x y]  

Stands for set position. Moves the turtle 
to the designated x y coordinates. The 
center point of the page is [0 0]. The 
maximum number for x and y is 9999.  

See pos and Private and Public Color 
Detection in the section Fundamentals 
in the Help System.  

Given that there is a turtle on the 
page:  

setpos [0 0]  
setpos [-50 50]  

setrotate  

list-of-turtle-
numbers-or-
names  

Sets an animation mode based on the 
turtle's heading. The range of possible 
headings (360 degrees) is divided by the 
number of shapes in the list and the turtle 
uses the appropriate shape. If there are 4 
shapes in the list, the turtle uses the first 
shape for a heading of -45 to 44, the 
second shape for 45 to 134, and so on. 
This mode can also be set in the turtle's 
backpack, in the State tab.  

See shape and setshape, and 
Animation - Changing Shapes Based 
on Heading in the section 
Fundamentals in the Help System.  

Given that there is a turtle on the 
page and these shapes names and 
numbers are defined:  

setrotate  
[north south east west]  
repeat 360 [rt 1]  
setrotate [1 2 3 4 5 6 7 
8]  
repeat 360 [rt 1]  

setshape 
(setsh)  

shape-name-or-
number  

 

setshape 
(setsh)  

list-of-names-or-
numbers  

Gives a shape or a set of shapes to the 
turtle. Setshape also resets the animation 
mode to Setshape if it was set to 
Setrotate. The maximum number for 
setshape is 128. When a list of shape 
names or numbers is given as input, each 
forward and back command makes the 
turtle cycle through the list of shapes. The 
shape can also be set by selecting one or 
several shapes from the Painting/Clipart 
palette and clicking on a turtle.  

See setrotate, shape, and Animation - 
Changing Shapes... in the section 
Fundamentals in the Help System.  

 

 

 

Given that there is a turtle on the 
page:  

setsh 1  
setsh "cat  
setsh [1 2 3]  
setsh [cat1 cat2 cat3]  
glide 50 0.1  
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setsize  

number  

Sets the size of the turtle. The original 
size is 40 and the minimum and 
maximum sizes are 5 and 160, 
respectively. Turtle shapes look nice 
when they are multiples of 20. You can 
also change the size of the turtle with the 
magnifiers.  

See size.  

Given that there is a turtle on the 
page:  

setsize 15  
repeat 12  
[setsize size + 5 wait 
5]  

setx  

number  

Sets the x coordinate of the current turtle. 
The y coordinate remains unchanged.  

Given that there is a turtle on the 
page:  

setx 100  
setx 0  

sety  

number  

Sets the y coordinate of the current turtle. 
The x coordinate remains unchanged.  

Given that there is a turtle on the 
page:  

sety 100  
sety 0  

shape  Reports the shape name or number, or 
the list of shape names or numbers of the 
current turtle.  

See setshape.  

Given that there is a turtle on the 
page:  

repeat 4 [setsh shape + 
1]  

size  Reports the size of the current turtle.  

See setsize and Changing the Turtle's 
Size in the section Fundamentals in the 
Help System.  

Given that there is a turtle on the 
page:  

setsize 15  
repeat 12  
[setsize size + 5 wait 
5]  

snaparea  

shape-number  

[x y]  

[xsize ysize]  

Copies the graphics in the defined area 
(page and wallpaper) and pastes it in a 
shape spot in the public Shapes Tab. [x 
y] is the top left starting point, and [xsize 
ysize] determines the size of the 
rectangle that is copied into the shape. To 
find out the values you need for the 
position and size, drag a region on the 
page and look for the x, y, xsize and ysize 
values in the Status bar.  

See snapshape and Copying 
Background Graphics into a Shape in 
the section Fundamentals in the Help 
System.  

 

 

Draw a complex background and 
look at the public Shapes Tab for the 
effect of this command:  

snaparea 1 [0 0] [50 60]  
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snapshape 

 

Copies the page graphics (not the 
wallpaper) behind the turtle into the 
current shape of the turtle. You cannot 
use snapshape if the turtle has its 
original turtle shape. The turtle must be 
completely visible on the page. 
Snapshape resets the turtle's size to 40 
(its original size) even if the size has been 
changed.  

If you want to copy the shape into an 
empty spot in the public Shapes Tab, set 
the turtle to this shape before using 
snapshape.  

See snaparea and Copying 
Background Graphics into a Shape in 
the section Fundamentals in the Help 
System.  

Given that there is a turtle on the 
page, NOT wearing the default turtle 
shape. Draw a complex background 
and look at the public Shapes Tab for 
the effect of this command:  

pd rt 11 fd 9999  
setsh 5  
snapshape  
cg  
pu fd 50  

snapshot  Takes a snapshot of the background. The 
next time a restore command is used, the 
background will be restored to what it was 
at the moment the snapshot was taken. 
Note that there is only one snapshot per 
project, and the snapshot is not saved 
with the project.  

See restore, freezebg and unfreezebg.  

Given that there is a turtle on the 
page:  

pd lt 11 fd 9999  
snapshot  
rt 22 fd 9999  
restore  

st  Stands for show turtle. Shows the current 
turtle.  

See ht.  

Given that there is a turtle on the 
page:  

t1, repeat 5 [ht wait 5 
st]  

stamp  Stamps a copy of the turtle on the 
background. The pen does not have to be 
down to stamp. You can also use the 
Stamper tool in the Toolbar to stamp the 
turtle's shape.  

See Stamping a Turtle in the section 
Fundamentals in the Help System.  

 

 

 

 

 

 

Given that there is a turtle on the 
page:  

repeat 10 [stamp fd 40]  
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talkto (tto)  

turtle-name  

 

talkto (tto)  

text-box-name  

 

talkto (tto)  

list-of-names  

Makes the turtle(s) or text box current. 
This command has the same effect as 
typing the name of a turtle or text box 
followed by a comma. This is the only 
way of making many turtles do the same 
thing at the same time.  

See ask, and Processes and Who in the 
section More Techniques in the Help 
System.  

Given that there are three turtles on 
the page:  

tto [t1 t2 t3]  
repeat 7 [fd 10 wait 1]  

tell  

turtle-name  

word-or-list  

 

tell  

list-of-turtle-
names  

word-or-list  

Sends a message for the turtle or turtles 
named as input to hear. Tell triggers the 
instruction found in the OnMessage field 
in the Rules Tab of the specified turtle's or 
turtles' backpack(s).  

See broadcast, message and sender. 
See also Rules Tab - OnMessage in the 
section Fundamentals in the Help 
System.  

In the Onclick field of t1's backpack:  

tell "t2 "here  

In the OnMessage field of t2's 
backpack:  

towards sender  

Click on t1.  

touchedturtle 
(tturtle)  

Reports the name of the turtle that is 
touched by the one running this 
command. Touchedturtle can only be 
used inside the OnTouching field of a 
turtle's backpack.  

See touching? and Rules Tab - 
OnTouching in the section 
Fundamentals in the Help System.  

In the Onclick field of t1's backpack:  

towards "t2 glide 9999 1  

In the OnTouching field of t1's 
backpack:  

if touchedturtle = "t2  
[lt 90]  

Click on t1.  
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touching?  

turtle-name  

turtle-name  

Reports true if the two turtles are 
touching each other; reports false if they 
are not touching. Touching? always 
reports false if one of the turtles is 
hidden.  

See touchedturtle and Rules Tab - 
OnTouching in the section 
Fundamentals in the Help System.  

Given that t1 and t2 exist on the 
page:  

to meet  
t1,  
forever [wander]  
waituntil [touching? "t1 
"t2]  
cancel [wander]  
end  

to wander  
seth random 360 glide 
100 1  
end  

towards  

turtle-name  

Sets the heading of the current turtle to 
aim towards the turtle whose name is 
given as input.  

See distance and seth.  

Given that t1 and t2 exist on the 
page:  

to go  
t1,  
forever [fd 1 check]  
end  

to check  
if 30 < distance "t2  
[towards "t2]  
end  

turtlesown  

word  

Assigns a state variable to all the turtles 
in the current project. This variable can 
then be set to a specific value for each 
turtle. This command creates a 
command-reporter pair of primitives that 
can be used in the current project only: 
the word set followed by the name of the 
variable (for example, turtlesown "speed 
creates a setspeed command) and the 
name of the variable (in this example, 
speed).  

The State Tab of the turtle's backpack 
displays the turtlesown variables. The 
value of the variable can also be set by 
double-clicking on the variable name in 
the turtle's backpack.  

After a turtlesown instruction, the value 
of the variable is empty until it is set.  

See giveturtle and State Variables in 
the section Programming in the Help 
System.  

 

Given that t1 and t2 exist on the 
page.  

turtlesown "start  
t1, setstart [-50 -51]  
t2, setstart [-30 -51]  
everyone [setpos start]  
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unfreezebg  Stands for unfreeze background. 
Unfreezes the background that was 
frozen by freezebg. When you click on 
the page icon in the Project Tab, a 
message appears in the Status Bar if the 
background is frozen.  

See freezebg, shapshot and restore.  

Given that there is a turtle on the 
page:  

to go  
setc "orange  
pd rt 11 fd 9999 wait 15 
freezebg  
setc "yellow  
rt 11 fd 9999 wait 15  
cg wait 15  
unfreezebg  
cg  
end  

who  Reports the name of the current turtle.  

See ask, listen, talkto, and Processes 
and Who in the section More 
Techniques.  

Given that there are many turtles on 
the page:  

everyone  
[fd 20 * butfirst who]  

xcor  Stands for x coordinate. Reports the x 
coordinate of the current turtle.  

See pos, setx and ycor.  

Given that there is a turtle on the 
page:  

repeat 360 [setx xcor + 
5 sety 100 * sin xcor]  

ycor  Stands for y coordinate. Reports the y 
coordinate of the current turtle.  

See pos, sety, and xcor.  

 

Given that there is a turtle on the 
page:  

repeat 360 [sety ycor + 
5 setx 100 * sin ycor]  

Turtle name 
followed by a 
comma 

 

A turtle name followed by a comma can 
be used as a command to make this turtle 
current. It is equivalent to a talkto 
command with that turtle's name as input. 

Given that t1 and myturtle exist on 
the page:  

t1,  
fd 50  
myturtle,  
bk 50  

Turtle name 
followed by 's  

A turtle name followed by an apostrophe 
and an s ( 's) is the equivalent of an ask 
instruction with that turtle's name as input. 

Given that t1 and t2 exist on the 
page:  

show ask "t1 [pos]  
[0 0]  
show t1's "pos  
[0 0]  
t2, setpos t1's "pos  
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Objects 
 

Primitive  

Input(s)  

Description  Examples  

ask  

turtle-or-text-name  

instruction-list  

 

ask  

list-of-names  

instruction-list  

Temporarily tells each element 
in the first input to run the 
instruction list. The first input 
can be the name(s) of one or 
many turtles or text boxes. Ask 
does not change the current 
turtle or text box. The 
apostrophe can be used to ask 
a turtle to report something.  

See also talkto.  

Given that t1, t2 and the text1 
exist on the page:  

ask [t1 t2] [clickon]  
ask "text1 
[cleartext]  
t2, setpos ask "t1 
[pos]  
t2, setpos t1's "pos  

freeze  

object-name  

 

freeze  

list-of-names  

 

freeze  

page-name  

Freezes objects so that they 
cannot be moved, resized, or 
removed with the mouse. The 
input is the name of an object 
on the page, or a list containing 
many object names. A page 
name can also be used as input 
to freeze all the elements 
contained in that page.  

See unfreeze, freezebg and 
unfreezebg. See also Freezing 
Objects in the section 
Fundamentals in the Help 
System.  

Given that these objects exist 
on the page:  

freeze "t1  
freeze [button1 
text1]  
freeze "page1  

get  

object  

property  

Reports a property of an object 
in the current project. The first 
input is the name of an object, a 
color, a page or the special 
word Project. The second input 
is a property name.  

Following is a list of the 
properties each object can 
have:  

 

 

Given that these objects exist 
on the page:  

show get "t1 "onclick  
show get "t1 "on?  
show get "button1 
"onclick  
show get "text1 "size  
show get "t1 "own  
show get "t1 "red  
show get "question 
"pos  
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Project:  

presentationmode? 
showtoolbar? showcc? 
showtabs? showstatusbar? 
showtechniques? dialogs  

Page:  

transition turtles texts buttons 
sliders melodies sounds music 
videos checkboxes 
roundbuttonsets listboxes 
dropdowns colordemons 
hyperlinks  

Turtle:  

visible? frozen? menu notes 
procedures onclick ontick 
ontouching onmessage onevent 
own on? colorname  

Button:  

visible? pos size onclick on? 
frozen? visible?  

Slider:  

visible? pos showname? limits 
value frozen? vertical? visible?  

Text:  

text visible? transparent? 
showname? frozen? pos size 
visible? onreadline, singleline?  

Public color detection:  

onturtle mouseclick  

Hyperlinks:  

visible? pos showname? 
frozen? link  

Media Objects:  

visible? pos showname? 
frozen? on?  
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Additional for Melodies:  

instrument volume tempo  

Additional for Video:  

size  

Question and Announce:  

pos  

Choosers (round buttons 
sets, etc.):  

pos value visible? showname? 
frozen? labels (except for check 
boxes)  

See get.  

getlabel  

object-name  

Reports the label (the text) of 
the current selection in the 
designated chooser (round 
button set, list box or drop down 
menu). The other option for 
reporting the current selection is 
to use the object name. show 
listbox1 reports the position of 
the current selection in the list of 
selections (reports 0 if nothing is 
selected) and show getlabel 
"listbox1 reports the label 
corresponding to that selection, 
as a long word.  

 
See Choosers and Dialog 
Boxes in the section 
Fundamentals in the Help 
System.  

Given that listbox1 exist on the 
page or in a dialog box:  

show getlabel 
"listbox1  
if (getlabel 
"radioset1) = "Yes  
[fd 50]  
setcolor getlabel 
"listbox1  

newbutton  

name  

[x y]  

instruction-list  

Creates a new button with the 
name and instruction specified, 
at the position [x y] indicated. 
The name cannot be more than 
32 characters (including 
spaces). The position [x y] is 
the top, left corner of the button. 
The button is created in the 
Once mode. It is sized to fit the 
instruction-list. At the time of 
creation, the label of the button 
is the same as its instruction. 
Use set to change the label.  

Given that this object doesn't 
already exist on the page:  

newbutton "mybutton  
[5 60]  
[note 65 5]  

The button shows its instruction 
as its label. Do this to set the 
label:  

set "mybutton "label 
"GO!  
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newcheckbox  

name  

[x y]  

label  

Creates a new check box at the 
position indicated, with the label 
provided. The name of the 
check box reports its current 
state: true if it is checked, false 
otherwise.  

Given that this object doesn't 
already exist on the page and 
doodle is in the turtle's OnClick 
field in Forever mode:  

newcheckbox "pen [0 
0] "Draw  
to doodle  
ifelse pen [pd] [pu]  
fd 50 rt random 360  
end  

newdropdown  

name  

[x y]  

list-of-labels  

Creates a new drop down menu 
at the position indicated and 
containing the list of labels 
provided. The name of the drop 
down menu reports the position 
of the current selection in the list 
of selections. The other option 
for reporting the current 
selection is to use getlabel. 
Show dropdown1 reports the 
position of the current selection 
(reports 0 if nothing is selected) 
and show getlabel 
"dropdown1 reports the label 
(text) corresponding to that 
selection as a word.  

Given that this object doesn't 
already exist on the page:  

newdropdown 
"colselect [0 0]  
[Red Green Bleu]  
if colselect = 0  
[announce [Choose 
one]]  

newlistbox  

name  

[x y]  

list-of-labels  

Creates a new list box at the 
position indicated and 
containing the list of labels 
provided. The name of the list 
box reports the position of the 
current selection in the list of 
selections. The other option for 
reporting the current selection is 
to use getlabel. Show listbox1 
reports the position of the 
current selection (reports 0 if 
nothing is selected) and show 
getlabel "listbox1 reports the 
label (text) corresponding to that 
selection.  

 

 

 

 

 

 

Given that this object doesn't 
already exist on the page:  

newlistbox "colselect 
[0 0]  
[Red Green Bleu]  
if colselect = 0  
[announce [Choose 
one]]  
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newroundbuttonset 

name  

[x y]  

list-of-labels  

Creates a new round button set 
at the position indicated and 
containing the list of labels 
provided. The name of the 
round button set reports the 
position of the current selection 
in the list of selections. The 
other option for reporting the 
current selection is to use 
getlabel. Show 
roundbuttonset1 reports the 
position of the current selection 
(reports 0 if nothing is selected) 
and show getlabel 
"roundbuttonset1 reports the 
text of the selection.  

Given that this object doesn't 
already exist on the page:  

newroundbuttonset 
"colselect  
[0 0] [Red Green 
Bleu]  
if colselect = 0  
[announce [Choose 
one]]  

newslider  

name  

[x y]  

[min max current]  

Creates a new slider using the 
specified name and at the 
position indicated. The position 
[x y] is the top, left corner of the 
slider. The last input is a list of 
three numbers representing the 
minimum, maximum, and 
current value of the slider. The 
minimum and maximum values 
are  

-9999 and 9999 respectively.  

Given that this object doesn't 
already exist on the page:  

newslider "step  
[100 100] [0 8 3]  
show step  
3  
setstep 5  
setstep [10 20 15]  

newtext  

name  

[x y]  

[xsize ysize]  

Creates a new text box using 
the name and size specified and 
at the position [x y] indicated. 
The position is the top, left 
corner of the box. The maximum 
[xsize ysize] is the size of the 
page in the project.  

Given that this object doesn't 
already exist on the page:  

newtext "mynotes [0 
0] [50 100]  
pr "Notes  

newturtle  

name  

Creates a new turtle with the 
name indicated. The new turtle 
appears at the position [0 0] and 
is hidden. Use st to make it 
visible. Newturtle makes the 
turtle that is created the current 
turtle.  

 

 

 

 

 

Given that this object doesn't 
already exist on the page:  

newturtle "newborn  
setx 30 st  
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remove  

object-name  

 

remove  

page-name  

 

remove  

variable-name  

Deletes an object, page, project 
variable created with 
createprojectvar or a turtle 
variable created with 
turtlesown or giveturtle. If the 
named object is not on the 
current page, MicroWorlds looks 
for it on the other pages in the 
project. If the input to remove is 
procedures, the Public 
Procedures Tab is cleared. If 
you remove the only page of a 
project, a new page called 
Page1 is created. You can also 
remove objects with the 
Remove option in the object's 
right-click menu on the page or 
in the Project Tab.  

Given that t1 exists on the page:  

remove "t1  

rename  

object-name  

new-object-name  

Sets a new name for the object 
or the page.  

Given that these objects exist:  

rename "t1 "myfriend  
rename "text1 
"mynotes  
rename "page1 "intro  

resetdialog  

name-of-dialog-box  

Resets all the choosers in the 
named dialog box to their 
default values. You can set the 
default value or round button 
sets, list boxes and drop down 
menus in their own dialog 
boxes. Without a resetdialog, 
the values previously set when 
you last used the dialog box are 
maintained when the dialog box 
is reopened.  

See Dialog Boxes in the 
section Fundamentals in the 
Help System.  

Given that dialog1 exists:  

dialog1  

Make some changes to the 
choosers. Click on Cancel.  

dialog1  

The selections you made earlier 
are still present in the dialog 
box. Click on OK.  

resetdialog "dialog1  
dialog1  

The values are reset.  

resetvideo  

name-of-video  

Resets the video to the 
beginning.  

Given that this object exists on 
the page:  

resetvideo "video1  
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set  

object  

property  

value  

Sets a property for an object to 
the specified value. The first 
input is the name of an object. 
The second input is a property 
name and the last one is the 
value.  

Project:  

presentationmode? 
showtoolbar? showcc? 
showtabs? showstatusbar? 
showtechniques?  

Page:  

transition  

Turtle:  

visible? frozen? menu notes 
procedures onclick ontick 
ontouching onmessage onevent 
own on? colorname  

Button:  

visible? pos size onclick on? 
frozen? visible?  

Slider:  

visible? pos showname? limits 
value frozen? vertical? visible?  

Text:  

text visible? transparent? 
showname? frozen? pos size 
visible? singleline?  

Public color detection:  

mouseclick, onturtle  

Hyperlinks:  

visible? pos showname? 
frozen? on? link  

 

 

Given that these objects exist 
on the page:  

set "text1 "visible? 
"false  
set "t1 "onclick  
[once [seth random 
360 fd 50]]  
set "t1 "red  
[once [rt 180]]  
set "slider1 
"showname? "true  
set "brown 
"mouseclick  
[silly-sound]  
set "blue "onturtle  
[once [announce [You 
win!]]]  
set "announce "pos [0 
0]  
set "page1 
"transition 2  
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Media Objects:  

visible? pos showname? 
frozen? on?  

Additional for Video:  

size  

Question and Announce:  

pos  

Choosers (round buttons 
sets, etc.):  

pos value visible? showname? 
frozen? labels (except for 
checkboxes)  

See set.  

talkto (tto)  

turtle-name  

 

talkto (tto)  

text-box-name  

 

talkto (tto)  

list-of-names  

 

 

 

 

 

 

 

Makes the turtle(s) or text box 
current. This command has the 
same effect as typing the name 
of a turtle or text box followed by 
a comma. This is the only way 
of making many turtles do the 
same thing at the same time.  

See ask, and Processes and 
Who in the section More 
Techniques in the Help 
System.  

Given that t1, t2 and t3 exist on 
the page:  

tto [t1 t2 t3]  
repeat 7 [fd 10 wait 
1]  
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unfreeze  

object-name  

 

unfreeze  

list-of-names  

 

unfreeze  

page-name  

Unfreezes the button, text box, 
turtle, slider, or any object on a 
page, so they can be changed 
using the mouse. A page name 
can also be used as input to 
unfreeze all the elements 
contained on that page. This 
command corresponds to the 
Unfreeze menu item accessible 
by right-clicking on object icons 
(previously frozen) in the Project 
Tab area. The eye tool can be 
used to move frozen objects. 
See freeze, freezebg and 
unfreezebg.  

See also Freezing Objects in 
the section Fundamentals in 
the Help System.  

Given that these objects exist 
on the page:  

unfreeze "t1  
unfreeze [button1 
text1]  
unfreze "page1  
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Text Boxes and Text Editing 
 

Primitive  

Input(s)  

Description  Examples  

ask  

turtle-or-text-
name  

instruction-list  

 

ask  

list-of-names  

instruction-list  

Temporarily tells each element in 
the first input to run the instruction 
list. The first input can be the 
name(s) of one or many turtles or 
text boxes. Ask does not change 
the current turtle or text box. The 
apostrophe can be used to ask a 
turtle to report something.  

See talkto.  

Given that text1 exists on the 
page:  

ask "text1 [cleartext]  

bottom  Puts the cursor (insertion point), in 
the current text box, at the end of 
the text. Try using this command in 
a button so that you can see the 
effect on the cursor.  

See top, sol, eol, and eot?.  

Given that there is a text box on 
the page:  

pr "hello  
top pr "say  
bottom pr "there  

cb  Stands for cursor back. Moves the 
cursor (insertion point) in the 
current text box to the previous 
character. Try using this command 
in a button so that you can see the 
effect on the cursor.  

See cf, cd, and cu.  

Given that there is a text box 
containing some text on the page:  

bottom  
repeat 5 [cb insert "x 
cb]  

cd  Stands for cursor down. Moves the 
cursor (insertion point) in the 
current text box to the next physical 
line. Try using this command in a 
button so that you can see the 
effect on the cursor.  

See cu, cf, and cb.  

Given that there is a text box 
containing some text on the page:  

top  
repeat 5 [cd insert "x 
]  

cf  Stands for cursor forward. Moves 
the cursor (insertion point) in the 
current text box to the next 
character. Try using this command 
in a button so that you can see the 
effect on the cursor. See cb, cd, 
and cu.  

Given that there is a text box 
containing some text on the page:  

top  
repeat 5 [cf insert "x 
]  
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cleartext (ct) 

 

Clears the text in the current text 
box.  

Given that there is a text box on 
the page:  

repeat 5 [pr "line]  
cleartext  

clipboard  Reports the contents of the text 
clipboard. The clipboard contains 
the last text that has been cut or 
copied using the cut or copy 
command, or the equivalent Edit 
menu items or Toolbar buttons. 
The Clear menu item and the 
Delete/Backspace keys do not 
affect the clipboard.  

See also select and paste.  

Given that there is a text box 
containing some text on the page:  

top select bottom cut  
repeat 2 [pr clipboard]  

copy  Puts a copy of the selected text in 
the clipboard. It unselects the 
current selection.  

See cut, paste and select.  

Given that there is a text box 
containing some text on the page:  

top  
select  
bottom  
copy paste wait 20 ct  

cu  Stands for cursor up. Moves the 
cursor (insertion point) in the 
current text box to the previous 
physical line. Try using this 
command in a button so that you 
can see the effect on the cursor.  

See cd, cb, and cf.  

Given that there is a text box 
containing some text on the page:  

bottom  
repeat 5 [cu insert "x 
]  

cut  Deletes the text selection in the 
current text box and puts a copy in 
the clipboard.  

See select, copy and paste.  

Given that there is a text box 
containing some text on the page:  

top  
select  
bottom  
cut wait 20 paste  

delete  Deletes the character to the right of 
the cursor (insertion point) in the 
current text box.  

Given that there is a text box on 
the page:  

ct  
pr "unfair  
top  
delete delete  
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eol  Stands for end of line. Moves the 
cursor (insertion point) in the 
current text box to the end of the 
current logical line. Try using this 
command in a button so that you 
can see the effect on the cursor.  

See sol.  

Given that there is a text box on 
the page:  

top eol insert "!!!  

eot?  Stands for end of text. Reports 
true if the cursor (insertion point) in 
the current text box is at the end of 
the text. Eot? is generally used to 
stop a procedure that processes 
information in a text box using 
cursor (insertion point) commands 
like cd, eol, etc.  

See bottom.  

Given that there is a text box 
containing some text on the page:  

to addhyphens  
top  
doall  
end  
to doall  
sol insert "- eol  
if eot? [stop]  
cd  
doall  
end  

exporttext  

pathname  

text-name  

Exports the text found in the 
designated text box, the Command 
Center or a public Procedures Tab 
to the file named indicated, in a text 
file format.  

For the pathname, use a simple 
file name to save the file in the 
current directory or full or relative 
pathname to save the file in a 
different directory. If the file name 
has no extension, the resulting file 
is a txt (plain text) file. Add a rtf 
extension to the file name to get a 
Rich Text Format file.  

The second input, text-name, must 
be a text box name or the special 
word cc (to export the text in the 
Command Center) or procedures 
(to export the text in the public 
Procedures Tab).  

This command is equivalent to the 
Export Text item in the File menu.  

See a loadtext and importtext. 
See also Exporting Text in the 
section Fundamentals in the Help 
System.  

 

 

Given that text1 exists on the 
page.  

exporttext "story.rtf 
"text1  
exporttext 
"C:\mydir\cmds "cc  
exporttext "procs 
"procedures  
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fontsize  Reports the font size used at the 
insertion point in the current text 
box. If text that has more than one 
font size is selected, fontsize 
reports the size of the text that was 
selected last.  

See setfontsize.  

Given that there is a text box on 
the page:  

pr "hello  
setfontsize fontsize + 
10  
pr "there  

found?  Reports true if the last search 
instruction was successful.  

Given that there is a text box 
containing some text on the page:  

to replaceall :this 
:bythat  
search :this  
if not found? [stop]  
insert :bythat  
replaceall :this 
:bythat  
end  

hidetext  Hides the current text box. You 
cannot type in a hidden text box, 
but primitives such as print, insert, 
and cleartext still work. This 
command is equivalent to the Hide 
function in the text box's right-click 
menu on the page and in the 
Project Tab. Text boxes can also 
be made invisible and visible 
through their dialog boxes. Use the 
eye tool to see all hidden text 
boxes, as well as open their dialog 
boxes.  

See showtext.  

 

 

 

 

 

 

 

 

 

Given that there is a text box on 
the page:  

hidetext  
wait 20  
showtext  
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importtext  

pathname  

text-name  

Imports the text from the named file 
into the text box, Procedures Tab, 
or Command Center.  

For the pathname, use a simple 
file name to import a file from the 
current directory or full or relative 
pathname to import a file in a 
different directory.  

The input for text-name must be 
the name of a text box or the 
special words cc (Command 
Center) or procedures (public 
Procedures Tab).  

This command is equivalent to the 
Import Text item in the File menu.  

See exporttext, loadtext and 
Importing Text in the section 
Fundamentals in the Help System. 

Given that text1 exists on the 
page and that such files exist:  

importtext "story.rtf 
"text1  
importtext 
"C:\mydir\cmds "cc  
importtext "brain 
"procedures  

insert  

word-or-list  

Inserts the input at the cursor 
position, in the current text box. 
The text is NOT followed by a 
carriage return or a line feed.  

See print.  

Given that there is a text box on 
the page:  

settc "violet insert "w  
settc "red insert "o  
settc "orange insert "w  

loadtext  

pathname  

Loads the text file in the current 
text box. For the pathname, use a 
simple file name to import a file 
from the current directory or full or 
relative pathname to import a file in 
a different directory.  

See importtext and Importing 
Text in the section Fundamentals 
in the Help System.  

Given that there is a text box on 
the page and that such files exist:  

loadtext "story  
loadtext 
"c:\projects\story  

newtext  

name  

[x y]  

[xsize ysize]  

Creates a new text box using the 
name and size specified at the 
position [x y] indicated. The 
position is the top, left corner of the 
box. The maximum [xsize ysize] is 
the size of the page in the project.  

Given that this text box doesn't 
exist on the page:  

newtext "mynotes [0 0] 
[50 100]  
pr "Notes  

opaque  

text-box-name  

Makes the designated text box 
opaque. This is equivalent to 
selecting Opaque in the text box's 
right-click menu, on the page or in 
the Project Tab. It is also 
equivalent to unchecking the box 
Transparent in the text box's dialog 
box. See transparent.  

Given that text1 exists on the 
page and it contains some text:  

transparent "text1  
opaque "text1  
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paste  Pastes a copy of the clipboard in 
the current text box. The clipboard 
contains the last text that has been 
cut or copied using the cut or copy 
command, or the equivalent Edit 
menu items and Toolbar buttons.  

See also select.  

Given that there is a text box 
containing some text on the page:  

top  
select  
bottom  
cut wait 5 paste paste  

print (pr)  

word-or-list  

Prints a word or list in the current 
text box. The text is followed by a 
carriage return and line feed 
sequence.  

See insert.  

Given that there is a text box 
containing some text on the page:  

bottom  
pr "  
print [The End]  

savetext  

pathname  

Saves the text found in the current 
text box in a text file format.  

The input can be a file name with 
or without an extension (and the 
file will be saved in the current 
directory) or a full or relative path. 
This command is equivalent to the 
Export Text item in the File menu. 
To save the Procedures Tab or the 
content of the Command Center as 
a text file, see exporttext.  

See loadtext and textlist. See 
also Exporting Text in the section 
Fundamentals in the Help System. 

Given that this text box exists on 
the page:  

savetext "story  
savetext "C:\proj\story  
savetext "story.rtf  

search  

word  

Tells MicroWorlds EX to search 
and select (highlight) the word in 
the current text box. Nothing 
happens if the word is not found., 
except for the fact that found? is 
set to false. Search starts 
searching at the insertion point. 
Use unselect to undo the 
highlighting effect of search.  

See also found?.  

Given that there is a text box 
containing some text on the page:  

to replaceall :this 
:bythat  
search :this  
if not found? [stop]  
insert :bythat  
replaceall :this 
:bythat  
end  

select  Tells MicroWorlds EX to start 
selecting text at the cursor position 
in the current text box. Any cursor 
motion (top, bottom, cu, cd, cf, 
and cb) will select text.  

 

 

 

Given that there is a text box 
containing some text on the page:  

top select bottom  
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selected  Reports as a word a copy of the 
characters in the block of selected 
text in the active text box. If no 
block of characters is selected, 
selected reports the empty word. 
Use parse to convert the block of 
characters into a list.  

Given that there is a text box 
containing some text on the page:  

top select bottom  
make "selection 
selected  
show :selection  

The content of the text box is 
reprinted in the Command Center.  

setfont  

word  

Sets the font for the selected text in 
the current text box. If no text is 
selected, setfont sets the cursor to 
use that font for typing. The input 
must be the name of a font in your 
system. If the name of the font has 
spaces, for example, Times New 
Roman, you must enclose the 
whole name in vertical bars. You 
can also set the text font by 
choosing Font from the Text menu. 

See settc, setfontsize, and 
setstyle.  

Given that there is a text box 
containing some text on the page:  

top select bottom  
setfont "arial  
setfont "|times new 
roman|  

setfontsize  

number  

Sets the font size for the selected 
text in the current text box. If no 
text is selected, setfontsize sets 
the cursor to use that font size for 
typing. You can also set the text 
size by choosing Font from the 
Text menu. We recommend using 
"True Type Fonts" (those with the 
symbol in the font dialog box). True 
type fonts allow many font sizes.  

See setfont, settc, and setstyle.  

Given that there is a text box 
containing some text on the page:  

top select bottom  
setfontsize fontsize + 
10  

setstyle  

word-or-list  

Sets the font style for the selected 
text in the current text box. If no 
text is selected, setstyle sets the 
cursor to use that style for typing. 
The input must be the name of a 
style (regular, bold, italic, 
underline). Multiple styles can be 
applied by inserting styles in a list. 
You can also set the text style by 
choosing Font from the Text menu. 

See setfont, setfontsize, and 
settc.  

 

 

Given that there is a text box 
containing some text on the page:  

top select bottom  
setstyle "italic  
setstyle [bold italic]  
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settc  

color-name-or-
number  

Stands for set text color. Sets the 
color for the selected text in the 
current text box. If no text is 
selected, settc sets the cursor to 
use that color for typing. The input 
can be the name of a color or a 
number. The original text color is 
black, or color number 9. You can 
also set the text color by choosing 
Color in the Text menu.  

See setfont, setfontsize, and 
setstyle.  

Given that there is a text box 
containing some text on the page:  

settc "violet insert "w  
settc "15 insert "o  
settc "orange insert "w  

show  

word-or-list  

Prints a word or a list in the 
Command Center. The outer level 
of brackets in a list are not shown.  

Given that t1 exists on the page:  

show "hello  
hello  
show [hello there]  
hello there  
show pos  
0 0  

showtext  Makes the current text box visible.  

See hidetext.  

Given that there is a text box 
containing some text on the page:  

hidetext  
wait 20  
showtext  

sol  Stands for start of line. Brings the 
cursor (insertion point) in the 
current text box to the beginning of 
the current logical line. Try using 
this command in a button so that 
you can see the effect on the 
cursor.  

See eol.  

Given that there is a text box 
containing some text on the page:  

sol delete insert "I  

stamptext  

text-box-name  

Leaves a copy of the designated 
transparent text box on the 
background. This is equivalent to 
using the Stamper tool on a 
transparent text box. 

See transparent.  

Given that text1 exists on the 
page and it contains some text:  

transparent "text1  
stamptext "text1  

Drag the text box away.  
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talkto (tto)  

turtle-name  

 

talkto (tto)  

text-box-name  

 

talkto (tto)  

list-of-names  

Makes the turtle(s) or text box 
current. This command has the 
same effect as typing the name of 
a turtle or text box followed by a 
comma.  

See ask, and Processes and Who 
in the Help System.  

Given that text1 exists on the 
page and it contains some text:  

tto [text1]  
cleartext  

tc  Stands for text color. Reports the 
number of the text color used in the 
current text box at the insertion 
point. If text that has more than one 
color is selected, tc reports the 
color of the last character that has 
been selected. See settc.  

Given that text1 exists on the 
page.  

to rainbow  
settc "violet pr tc  
settc "red pr tc  
settc "orange pr tc  
end  

textcount  

text-box-name  

Reports the number of lines in the 
named text box. Lines are 
delimited by carriage returns and 
line feed sequences (they are 
logical lines, not physical lines). 
Empty lines are taken into account. 
The number that textcount reports 
is the maximum number that can 
be used with textitem.  

See textpick, count, and 
Programming With Texts in the 
Programing section in the Help 
System.  

Given that text1 exists on the 
page and it contains some text. 
The result is just an example.  

show textcount "text1  
33  

textitem  

line-number  

text-box-name  

Reports the designated "line" of the 
named text box. Lines are 
delimited by carriage returns and 
line feed sequences (they are 
logical lines, not physical lines). 
Empty lines are taken into account. 
The first input must be between 1 
and the number of lines in the text 
box. The line reported by textitem 
is a long word (a sequence of 
characters including spaces). Use 
parse to turn a long word into a list. 

See textpick, textcount, and 
Programming With Texts in the 
Programing section in the Help 
System.  

Given that text1 exists on the 
page and it contains some text. 
The result is just an example.  

show textitem 2 "text1  
This is the second line  
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textlist  Reports a list containing the names 
of text files in the current directory. 
Only text type files (extensions txt 
or rtf) are shown.  

See files, projectlist, and pictlist.  

The result is just an example.  

show textlist  

mytext.txt 
listoffriends.rtf  

textpick  

text-box-name  

Reports the text of a randomly-
chosen line from the named text 
box. Lines are delimited by 
carriage returns and line feed 
sequences (they are logical lines, 
not physical lines). Textpick can 
pick empty lines. The line reported 
by textpick is a long word (a 
character string including spaces). 
Use parse to turn a long word into 
a list.  

See textitem, textcount, and 
Programming With Texts in the 
Programing section in the Help 
System.  

Given that text1 and text2 exists 
on the page and text1 contains 
some text. One of the lines of 
text1 is printed in text2.  

settext2 textpick 
"text1  

textwho  Reports the name of the current 
text box. You can change the 
current text box using the text box 
name followed by a comma or with 
talkto.  

Given that text1 exists on the 
page and it contains some text. 
The result is just an example.  

show textwho  
text1  
if textwho = "text1 
[ct]  

top  Moves the cursor (insertion point) 
to the beginning of the text in the 
current text box. Try using this 
command in a button so that you 
can see the effect on the cursor.  

See bottom.  

Given that there is a text box on 
the page:  

pr "there! top print 
"Hello  

transparent  

text-box-name  

Makes the designated text box 
transparent. This is equivalent to 
selecting Transparent in the text 
box's right-click menu, on the page 
or in the Project Tab. An empty text 
box cannot be made transparent.  

See opaque.  

Given that text1 exists on the 
page and it contains some text:  

transparent "text1  
opaque "text1  

unselect  Undoes the highlighting effect of 
select or search.  

Given that there is a text box on 
the page and it contains some 
text:  

top select bottom  
setfont "|Comic Sans 
MS| unselect  
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Text box name 
followed by a 
comma  

A text box name followed by a 
comma can be used as a 
command to make this text box 
current. It is equivalent to a talkto 
command with that page's name as 
input.  

Given that these text boxes exist 
on the page:  

text1,  
pr "hello  
mytext,  
pr "there  
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Words and Lists 
 

Primitive  

Input(s)  

Description  Examples  

ascii  

char  

Stands for American Standard 
Code for Information Interchange. 
Reports the ASCII number which 
represents the character.  

See char.  

Given that there is a text box on 
the page:  

to encoder  
top repeat count text1 
[encode]  
end  

to encode  
select cf cut  
insert char  
(ascii clipboard) + 3  
end  

butfirst (bf)  

word-or-list  

Reports all but the first component 
of a word or list.  

See butlast, first, and last.  

Given that there is a text box on 
the page:  

to triangle :word  
if :word = " [stop]  
pr :word  
triangle butfirst 
:word  
end  

butlast (bl)  

word-or-list  

Reports all but the last component 
of a word or list.  

See butfirst, first, and last.  

Given that there is a text box on 
the page:  

to revprint :word  
if :word = " [pr " 
stop]  
insert last :word  
revprint butlast :word  
end  
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char  

number  

Stands for character. Reports the 
character represented by the 
ASCII number given as input. The 
number must be between 32 and 
255. An exception is char 9, the 
tab character.  

See ascii.  

Given that there is a text box on 
the page:  

to decoder  
top  
repeat count text1 
[decode]  
end  

to decode  
select cf cut  
insert char  
(ascii clipboard) - 3  
end  

count  

word-or-list  

Reports the number of 
components in the word or the list.  

See item and textcount.  

Given that text1 exists on the 
page and it contains some text. 
The result is just an example.  

show count "hello  
5  
show count [hello 
there]  
2  
show count text1  
42  

empty?  

word-or-list  

Reports true if the input is an 
empty word or empty list.  

Given that text1 exists on the 
page and it contains some text:  

show empty? "  
true  
show empty? []  
true  
show empty? text1  
false  

to insist  
question [Your name 
please...]  
if empty? answer 
[insist]  
end  

equal?  

word-or-list1  

word-or-list2  

Reports true if the two inputs are 
equal. The inputs may be words, 
numbers, or lists.  

See identical? and =.  

 

 

show equal? "A "a  
true  
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first  

word-or-list  

Reports the first component of the 
word or list.  

See butfirst, butlast, and last.  

Given that text1 exists on the 
page and it contains some text. 
The result is just an example.  

show first "hello  
h  
show first [Hello 
there]  
Hello  
show first text1  
T  

fput  

word-or-list  

list  

Stands for first put. Reports the list 
created by adding the first input at 
the beginning of the second input. 
The second input has to be a list.  

See lput.  

show fput "a [e i o u 
y]  
a e i o u y  

identical?  

word-or-list1  

word-or-list2  

Reports true if both inputs are 
identical. A word and a list 
containing the same word are not 
identical. Corresponding 
characters of each input must 
match in terms of uppercase and 
lowercase letters. (Style, font, and 
text color are ignored.)  

See equal?.  

show identical? "a "a  
true  
show identical? "Hello 
"hello  
false  

item  

number  

word-or-list  

Reports the specified element of a 
word or a list. The first input must 
be between 1 and the number of 
elements in the word or the list.  

Given that text1 exists on the 
page and it contains some text. 
The result is just an example.  

show item 2 "hello  
e  
show item 2 [Hello 
there]  
there  
show item 2 text1  
h  

last  

word-or-list  

Reports the last component of the 
word or list.  

See first and butlast.  

Given that there is a text box on 
the page:  

to revprint :word  
if :word = " [pr " 
stop]  
insert last :word  
revprint butlast :word  
end  
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list  

word-or-list1  

word-or-list2  

 

(list  

word-or-list1  

word-or-list2  

word-or-list3....)  

Reports one list made by 
combining the inputs (words or 
lists). If more than two inputs are 
used (or only one input), list and 
its inputs must be enclosed in 
parentheses. List maintains the 
structure of its input elements.  

See sentence.  

Given that there is a turtle on the 
page:  

show list 2 3  
2 3  
show list "a [b]  
a [b]  
show (list "a "b "c 
"d)  
a b c d  
make "x 10 make "y 20  
setpos list :x :y  

list?  

word-or-list  

Reports true if the input is a list.  

See word?.  

Given that there is a turtle on the 
page:  

show list? pos  
true  
show list? heading  
false  

lput  

word-or-list  

list  

Stands for last put. Reports the list 
created by adding the first input at 
the end of the second.  

See fput.  

show lput "y [a e i o 
u]  
a e i o u y  

member?  

word-or-list1  

word-or-list2  

Reports true if the first input is a 
component of the second. Note 
that a list cannot be a component 
of a word.  

Given that there is a text box on 
the page and it contains some 
text:  

to quiz  
question [Washington 
is in...]  
ifelse member? answer 
[U.S.A. US USA U.S. 
|United States|]  
    [announce 
[Congrats!]]  
    [announce [Oops]]  
end  

number?  

word-or-list  

Reports true if the input is a 
number.  

See word? and list?.  

to insist  
question [How old are 
you?]  
if not number? answer  
   [insist]  
end  
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parse  

word  

Turns character strings into plain 
lists. Spaces and carriage returns, 
and linefeed sequences contained 
in the character string become 
separators in the list. Parse can be 
used to turn the long word (a 
sequence of characters including 
spaces) reported by text boxes into 
lists of words.  

The result is just an example.  

question [Type in a 
sentence]  
show answer  
This is a sentence  
show count answer  
18  
show count parse 
answer  
4  

pick  

word-or-list  

Reports an element chosen 
randomly from the word or the list. 
Picking from a word reports a 
character, picking from a list 
reports an element of the list (a 
word or a list).  

See textpick.  

Given that these turtles exist on 
the page. The result is just an 
example.  

show pick "hello  
e  
talkto pick [t1 t2 t3 
t4]  
fd 30  

sentence (se)  

word-or-list1  

word-or-list2  

 

(sentence  

word-or-list1  

word-or-list2  

word-or-list3...)  

 

 

 

 

 

 

 

 

Reports a list which is made up of 
its inputs (words or lists). 
Sentence can take more than 2 
inputs when sentence and the 
inputs are enclosed in 
parentheses.  

See list.  

Given that these turtles exist on 
the page:  

show se "Hello "there  
Hello there  
to middle  
t2, setpos sentence  
((t1's "xcor)+(t3's 
"xcor)) / 2  
((t1's "ycor)+(t3's 
"ycor)) / 2  
end  
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word  

word-or-list1  

word-or-list2  

 

(word  

word-or-list1  

word-or-list2   

word-or-list3...)  

Combines its inputs into one word 
and reports the word. Word can be 
used to make a list into a word. 
Word can take one input or more 
than 2 inputs when word and the 
inputs are enclosed in 
parentheses.  

See list and word?.  

Given that there is a text box on 
the page:  

to oneup :word  
print sentence [You 
may be] :word  
print sentence  
[But I am]  
word butlast :word 
"ier  
end  

Try:  

oneup "happy  

word?  

word-or-list  

Reports true if the input is a word.  

See number? and list?  

show word? "hello  
true  
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Screen Management 
 

Primitive  

Input(s)  

Description  Examples  

cc  Stands for clear the Command 
Center. Clears the text in the 
Command Center.  

repeat 5 [show "flash 
wait 5 cc]  

getpage  

page-name  

Displays the page. The input 
must be the name of a page in 
the current project. Typing the 
page name alone has the same 
effect.  

Given that there are several 
pages in the project (click on the 
page before you start because 
readchar works when the page is 
the current "active" area):  

to gotopagewhenkey 
:page  
let [a readchar]  
getpage :page  
end  

getproject  

pathname  

Gets the project indicated (the 
current project is not saved). The 
input must be the name of a 
project in the current directory or 
a full or relative path to access 
another directory.  

Getproject can load projects 
with extensions mwx 
(MicroWorlds EX), mw2 
(MicroWorlds Pro 
uncompressed) or mwz 
(MicroWorlds Pro compressed).  

See saveproject.  

 

 

 

 

 

 

 

 

Given that these files exist:  

getproject "sunset  
getproject "|My 
Project|  
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merge  

pathname  

word-or-list-of-
types  

Imports pages, procedures, or 
shapes from another project into 
the current project. The first input 
must be the name of a project in 
the current folder or a full or 
relative path to access a different 
folder. This is the project you 
want to import from.  

The second input can be the 
name of a specific page, a list of 
page names, the word 
procedures (to import the 
procedures from the project 
Procedures Tab and project 
variables), pages (to import all 
the pages), or shapes (to 
replace all the shapes in the 
current project's Shapes Tab). 
Instead of using merge, we 
highly recommend using Import 
Turtle to import shapes and/or 
procedures included in a turtle's 
backpack. If there are names in 
the source project that are the 
same as those in the current 
project, the new names will be 
renamed with a number.  

Given that these files exist:  

merge "clocks 
"procedures  

Imports the procedures and 
project variables.  

merge "clocks "pages  

Imports all the pages.  

merge "clocks [page1 
page3]  

Imports individual pages.  

merge 
"C:\projects\scene 
"shapes  

Replaces all the public shapes in 
the current project.  

namepage (np)  

page-name  

Names the page being displayed 
with the input. Namepage 
corresponds to the Name Page 
function in the Pages menu. 
Once the page is named, the 
page-name is a command that 
displays that page.  

Given that this page doesn't 
already exist:  

namepage "presentation  

newpage  Opens a new page called Pagex 
(x is the next available number).  

 

 

 

 

 

 

 

 

newpage  
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newprojectsize  

[xsize ysize]  

Sets the page size on the 
computer screen for new 
projects. The input is a list of two 
numbers: the width and the 
height of the page in turtle steps. 
Before using newprojectsize, 
there must be an empty project 
on the screen. The page size of 
a project is saved with the 
project. The minimum size is 40 
by 40 and the maximum size is 
2000 by 2000. The default 
project size is 744 by 426 when 
the display setting (in the Control 
Panel) is 1024 x 768 and 592 by 
322 when the display setting (in 
the Control Panel) is 800 x 600. 
This command corresponds to 
the New Project Size function in 
the File menu.  

See File Menu in the section 
Fundamentals and Posting 
Projects on the Web in the 
section More Techniques in the 
Help System.  

Choose New Project from the 
File menu so there is a perfectly 
empty project on the screen.  

newprojectsize [40 40]  
newprojectsize 
"standard  

Resets the project size to the 
default size.  

nextpage  Displays the next page in the 
page list. Pages are listed 
alphabetically in the page list. 
Rename your pages to create 
the desired sequence.  

See pagelist, prevpage and 
Pages Menu in the section 
Fundamentals in the Help 
System.  

Given that there are several 
pages in the project:  

repeat count pagelist  
[nextpage wait 10]  

pagelist  Reports a list containing the 
names of all the pages in the 
current project. The first name 
reported by pagelist is always 
the current page. The remaining 
pages in the project are listed 
alphabetically.  

Given that there are several 
pages in the project:  

repeat count pagelist  
[nextpage wait 10]  

prevpage  Stands for previous page. 
Displays the previous page in 
the page list. Pages are listed 
alphabetically in the page list. 
Rename your pages to create 
the desired sequence.  

See pagelist, nextpage and 
Pages Menu in the section 
Fundamentals in the Help 
System.  

 

Given that there are several 
pages in the project:  

repeat count pagelist  
[prevpage wait 10]  



MicroWorlds EX Vocabulary 

123 

presentationmode  Hides the Tabs, Command 
Center, Toolbar, Status Bar, and 
MicroWorlds EX menus. The 
project is centered on the screen 
and the background is filled in. 
Presentationmode is used to 
display completed projects. To 
return to MicroWorlds EX's 
regular mode, use 
presentationmode again (using 
a button or another clickable 
object), press Esc or double-
click in the area surrounding 
your project. This command 
corresponds to the Presentation 
Mode item in the View menu and 
button in the Toolbar.  

presentationmode  

projectsize  Reports the current project size, 
in turtle steps.  

See newprojectsize.  

show projectsize  

setfooter  

word-or-list  

Sets the contents of the footer 
on printouts. Normally, the footer 
is empty. Use the empty list as 
input if you do not want any 
footer after using setfooter.  

setfooter [MicroWorlds 
Lovers, Grade 4]  
setfooter []  

wallpaper  Displays the Wallpaper page. 
See The Wallpaper in the 
section Fundamentals in the 
Help System.  

Given that page1 exists in the 
project:  

wallpaper pd fd 100 
page1 cg  
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Disk Access 
 

Primitive  

Input(s)  

Description  Examples  

chdir  

pathname  

Stands for change directory. 
Changes the current drive 
and/or subdirectory name to 
pathname. To return to the 
desktop, use the volume name 
alone as input to chdir. Use 
vertical bars if the name 
contains spaces.  

See currentdir and directories. 

Given that these directories exist.  

chdir "Media  
chdir "|C:\MicroWorlds\My 
Work|  

currentdir  Stands for current directory. 
Reports the current directory 
that was set.  

See chdir.  

The result is just an example.  

show currentdir  
C:\MicroWorldsEX\projects  

directories  Reports a list of subdirectory 
names. To change directories 
through a command, use chdir.  

See chdir.  

The result is just an example.  

show directories  
Media My Work Projects  

A directory name made up of more 
than one word will look like two files 
in the list. Use make and names so 
that the actual names are enclosed in 
vertical bars. In this example, "My 
Work" is the name of one directory.  

make "dirs directories  
show names  
make "dir [Media |My 
Work| Projects]  
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erfile  

pathname  

Stands for erase file. Erases 
any type of file if it is not locked. 
The input must be the name of a 
file in the current directory or a 
full pathname. Use vertical bars 
if the name contains spaces.  

Given that these files exist:  

erfile "farm  
erfile "C:\projects\farm  

If one of the elements of the path has 
spaces, vertical bars must enclose 
the whole path:  

erfile "|C:\My 
projects\farm|  

When there is more than one file with 
the same name, you need to add the 
extension.  

erfile "quake.mw2  

exporttext  

pathname  

text-name  

Exports the text found in the 
designated text box, the 
Command Center or public 
Procedures Tab to the file 
named indicated, in a Unicode 
text file format.  

For the pathname, use a simple 
file name to save the file in the 
current directory or full or 
relative pathname to save the 
file in a different directory. If the 
file name has no extension, the 
resulting file is a txt (plain text) 
file. Add a rtf extension to the file 
name to get a Rich Text Format 
file.  

The second input, text-name, 
must be a text box name or the 
special word cc (to export the 
text in the Command Center) or 
procedures (to export the text in 
the public Procedures Tab).  

This command is equivalent to 
the Export Text item in the File 
menu.  

See a loadtext and importtext. 
See also Exporting Text in the 
section Fundamentals in the 
Help System.  

 

 

Given that text1 exists on the page.  

exporttext "story.rtf 
"text1  
exporttext "C:\mydir\cmds 
"cc  
exporttext "procs 
"procedures  
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exportturtle  

pathname  

Saves the current turtle on disk. 
The turtle file contains the turtle 
and all the contents of its 
backpack. If the pathname is 
just a word, the turtle is saved in 
the current directory with the 
extension mwa. An exported 
turtle can be imported or 
dragged and dropped into a 
different project, or emailed.  

See importturtle.  

Given that there is a turtle on the 
page:  

exportturtle "model  

files  

filetype  

Outputs a list of files of the given 
filetype in the current directory. 
If the input is "*", all file types are 
taken into account.  

See chdir and currentdir.  

Given that these files exist:  

show files "txt  
My Work report  

A file name made up of more than 
one word will look like two files in the 
list. Use make and names so that 
the actual names are enclosed in 
vertical bars. In this example, "My 
Work" is the name of one text file.  

make "texts files "txt  
show names  
make "texts [|My Work| 
report]  

importtext  

pathname  

text-name  

Imports the text from the named 
file into the text box, Procedures 
Tab, or Command Center.  

For the pathname, use a simple 
file name to import a file from the 
current directory or full or 
relative pathname to import a file 
in a different directory.  

The input for text-name must be 
the name of a text box or the 
special words cc (Command 
Center) or procedures (public 
Procedures Tab).  

This command is equivalent to 
the Import Text item in the File 
menu.  

See exporttext, loadtext and 
Importing Text in the section 
Fundamentals in the Help 
System.  

 

Given that these files exist and text1 
exists on the page:  

importtext "story.rtf 
"text1  
importtext "C:\mydir\cmds 
"cc  
importtext "brain 
"procedures  
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importturtle  

pathname  

Imports the turtle file on the 
current page. The turtle file 
contains all the characteristics of 
the turtle (the contents of its 
backpack). A turtle file is created 
by the command exportturtle, 
or by the options Export and 
Mail it in the turtle's right-click 
menu.  

See exportturtle and 
Exporting, Importing and 
Mailing Turtles in the section 
Fundamentals in the Help 
System.  

Given that this turtle file exists:  

importturtle "model  

loadpict  

pathname  

Stands for load picture. Loads 
the picture on the current page. 
The input must be the name of a 
picture file that MicroWorlds EX 
supports in the current directory 
or a full or relative path.  

See savepict and Importing 
Pictures in the section 
Fundamentals in the Help 
System.  

Given that these files exist:  

loadpict "scene  
loadpict 
"c:\projects\scene  
loadpict 
"media\tornado1.jpg  

loadshape  

pathname  

shape-number  

Loads the specified picture file 
into the specified shape spot in 
the public Shapes Tab. The 
picture file name becomes the 
name of the shape if there is no 
other shape with that name in 
that Tab.  

The file must be the name of a 
picture file that MicroWorlds EX 
supports in the current directory 
or a full or relative path. The 
shape-number can be any 
number from 1 to 128.  

See saveshape and Importing 
and Exporting Pictures in the 
section Fundamentals in the 
Help System.  

 

 

 

 

 

Given that these files exist:  

loadshape "volcano 20  
loadshape 
"c:\picts\volc.gif 20  
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loadtext  

pathname  

Loads the text file in the current 
text box. For the pathname, use 
a simple file name to import a 
file from the current directory or 
full or relative pathname to 
import a file in a different 
directory.  

See importtext and Importing 
Text in the section 
Fundamentals in the Help 
System.  

Given that these files exist and there 
is a text box on the page:  

loadtext "story  
loadtext 
"c:\projects\story  
loadtext "media\quake-
Italy  

merge  

pathname  

word-or-list-
of-types  

Imports pages, procedures, or 
shapes from another project into 
the current project. The first 
input must be the name of a 
project in the current folder or a 
full or relative path to access a 
different folder. This is the 
project you want to import from.  

The second input can be the 
name of a specific page, a list of 
page names, the word 
procedures (to import the 
procedures from the project 
Procedures Tab and project 
variables), pages (to import all 
the pages), or shapes (to 
replace the shapes in the current 
project's Shapes Tab). Instead 
of using merge, we highly 
recommend using Import Turtle 
to import shapes and/or 
procedures included in a turtle's 
backpack. If there are names in 
the source project that are the 
same as those in the current 
project, the new names will be 
renamed with a number.  

 

 

 

 

 

 

 

Given that these files exist:  

merge "clocks "procedures  

Imports the procedures and project 
variables.  

merge "clocks "pages  

Imports all the pages.  

merge "clocks [page1 
page3]  

Imports individual pages.  

merge "C:\projects\scene 
"shapes  

Replaces public shapes in the 
current project (shape numbers that 
were not blank in the imported file).  
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pictlist  Stands for picture list. Reports 
a list containing the names of 
picture files in the current 
directory. Only the files with 
picture formats that MicroWorlds 
EX supports (created using 
savepict or other applications) 
are shown.  

See textlist, projectlist, and 
files. See also Importing and 
exporting Pictures in the section 
Fundamentals in the Help 
System.  

The result is just an example.  

show pictlist  
mybackground.bmp MW.gif  

A file name made up of more than 
one word will look like two files in the 
list. Use make and names so that 
the actual names are enclosed in 
vertical bars. In this example, 
"autumn scene.gif" is the name of 
one file.  

make "picts pictlist  
show names  
make "picts 
[mybackground.bmp |autumn 
scene.gif| ]  

 

 

 

 

placepict  

pathname  

[x y]  

size  

Stands for place picture. 
Imports a picture file, places it at 
the designated position, and 
adjusts its size to fit the size 
indicated. The first input is the 
file name in the current directory 
or a full or relative pathname; 
the second input is the position 
for the top, left corner of the 
picture, and the third input is the 
size of the image on the page, in 
x and y turtle steps.  

 

 

 

 

 

 

 

placepict "cat [0 0] [100 100]  
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projectlist  Reports a list containing the 
names of MicroWorlds EX and 
MicroWorlds Pro projects in the 
directory (mwx, mw2, mwz files)  

See textlist, pictlist, and files.  

The result is just an example.  

show projectlist  
maze.mwz my 
adventure.mmwx  

A file name made up of more than 
one word will look like two files in the 
list. Use make and names so that 
the actual names are enclosed in 
vertical bars. In this example, "my 
adventure" is the name of one 
project.  

make "projects 
projectlist  
show names  
make "projects [maze.mwz 
|my adventure.mwx|]  

savepict  

pathname  

Stands for save picture. Saves 
the current page and its 
background as a picture file. The 
default file format (if you don't 
specify a format using an 
appropriate graphic file 
extension) is PNG.  

When you use the savepict 
command, the turtles, buttons, 
text boxes, and other objects are 
not part of the background. 
Stamped images and stamped 
text are part of the background. 
Use the File menu function 
Export Page Image to save the 
picture of the page including all 
objects.  

Savepict saves the file in the 
current directory unless you use 
a full or relative pathname. See 
Importing and Exporting 
Pictures in the section 
Fundamentals in the Help 
System.  

savepict "scene  
savepict 
"C:\projects\scene  
savepict "scene.jpg  

saveproject  Saves the current project without 
closing it. The project must have 
a name in order for this 
command to work. This is 
equivalent to the Save item in 
the File menu. Use this primitive 
if you want to save your project 
before getting another project 
with getproject.  

saveproject  
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saveshape  

pathname  

number  

Saves the specified shape from 
the project Shapes Tab as a 
picture file. Use a simple file 
name to save the file in the 
current directory or full or 
relative pathname to save the 
file in a different directory.  

If the file name has no 
extension, the resulting file is a 
bmp image. Add a jpg, gif or png 
extension to the file name to get 
a specific file format.  

Given that there is a turtle on the 
page with shapes in the spot 1.  

saveshape "moon 1  
saveshape "moon.jpg 1  
saveshape 
"c:\graph\moon.jpg 1  

savetext  

pathname  

Saves the text found in the 
current text box in a Unicode 
text file format.  

The input can be a file name 
with or without an extension 
(and the file will be saved in the 
current directory) or a full or 
relative path. This command is 
equivalent to the Export Text 
item in the File menu. To save 
the Procedures Tab or the 
content of the Command Center 
as a text file, see exporttext.  

See loadtext and textlist. See 
also Exporting Text in the 
section Fundamentals in the 
Help System.  

Given that there is a text box on the 
page and it contains some text:  

savetext "story  
savetext "C:\proj\story  
savetext "story.rtf  

textlist  Reports a list containing the 
names of text files in the current 
directory. Only text type files 
(extensions txt or rtf) are shown.  

See files, projectlist, and 
pictlist.  

The result is just an example.  

show textlist  
mytext.txt 
listoffriends.rtf  

A file name made up of more than 
one word will look like two files in the 
list. Use make and names so that 
the actual names are enclosed in 
vertical bars. In this example, 
telephone numbers is the name of 
one file.  

make "texts textlist  
show names  
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Control, Logic, Events, and Processes 
 

Primitive  

Input(s)  

Description  Examples  

and  

true-or-false1  

true-or-false2  

 

(and  

true-or-false1  

true-or-false2  

true-or-false3...)  

Reports true if all its inputs report 
true. If more than two inputs are 
used, and and its inputs must be 
enclosed in parentheses.  

See or and not.  

The result is just an example.  

show and pos = [0 0] 
heading = 0  
true  

cancel  

instruction-list  

Stops the process given as input. 
The process must have been 
launched using launch, when, 
forever, buttons, or clickable 
turtles. The input must be the 
exact same instruction list that 
started the process.  

See Stopping Processes in the 
section More Techniques in the 
Help System .  

Given that mytune is an existing 
audio object:  

to delay  
launch [mytune]  
wait random 200  
cancel [mytune]  
end  

carefully  

word-or-list-to-
run1  

word-or-list-to-
run2  

Runs the first input, a word or list 
of instructions. If the first input 
contains an error, carefully runs 
the second input, a word or list of 
instructions and sets 
errormessage to the error that 
occurred. If there is no error in the 
first input, the second input is 
ignored.  

See Carefully in the section More 
Techniques in the Help System.  

To be tried twice.  

to createifdoesntexist  
carefully  
[newturtle "newborn]  
[]  
setx 30 st  
end  

clickoff  Simulates a mouse click on the 
current turtle, turning it off if it was 
on. This command has an effect 
only if the turtle is programmed to 
react to a mouse click. See 
clickon, listen, and Turtles and 
Clickon in the section More 
Techniques in the Help System.  

Given that there are several turtles 
on the page, with OnClick 
instructions:  

everyone [clickon]  
t1, clickoff  
everyone [clickoff]  
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clickon  Simulates a mouse click on the 
current turtle, turning it on if it was 
off. This command has an effect 
only if the turtle is programmed to 
react to a mouse click.  

See clickoff, listen, and Turtles 
and Clickon in the section More 
Techniques in the Help System.  

Given that there are several turtles 
on the page with OnClick 
instructions:  

t1, clickon  
everyone [clickon]  

dolist  

range  

instruction-list  

Runs the instruction list for each 
item in a list. The first input, 
range, is a list with a temporary 
variable name and a list of items. 
The second input is a list of 
instructions that uses the variable 
name included in the first input. Be 
careful about the absence or 
presence of the ":" before the "i".  

See dotimes.  

Given that there is a turtle on the 
page:  

dolist [i [15 25 35]]  
[setc :i wait 4]]  

done?  

instruction-list  

Reports true if the process 
indicated is completed. The 
process must have been launched 
using launch or forever. The 
input must be an exact copy of the 
instruction list that started the 
process. Done? can be used as 
an input to waituntil in order to 
synchronize events.  

Given that jazz is an existing audio 
object and t1 is a turtle with an 
OnClick instruction:  

to dance  
launch [jazz]  
everyone [clickon]  
waituntil [done? 
[jazz]]  
everyone [clickoff]  
end  

dotimes  

maximum  

instruction-list  

Runs the instruction list for all 
values starting with 0 up to the 
specified maximum value. The 
first input is a list with a temporary 
variable name and a maximum 
number. The second input is a list 
of instructions that uses the 
variable name included in the first 
input. Be careful about the 
absence or presence of the ":" 
before the "i".  

See dolist.  

Given that there is a text box on 
the page:  

dotimes [i 4] [pr se :i 
sqrt :i]  

errormessage  Reports the last error message 
trapped by carefully. If 
errormessage reports an empty 
word, it means that the last 
operation using carefully did not 
report an error.  

See carefully and Carefully in the 
section More Techniques in the 
Help System.  

To be tried twice.  

to create  
carefully  
[newturtle "newborn]  
[show errormessage]  
setx 30 st  
end  
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everyone  

instruction-list  

Makes all the turtles on the current 
page run the instruction, one after 
the other.  

See ask and talkto.  

Given that there are several turtles 
on the page:  

everyone [glide -80 2]  

forever  

word-or-list-to-
run  

Runs the input repeatedly as an 
independent parallel process. Use 
cancel, the Stop All menu item 
(Edit menu) or button (Toolbar), or 
Ctrl+Break to stop the process.  

See launch and Timing and 
Synchronization in the section 
More Techniques in the Help 
System.  

Given that these turtles exist on 
the page:  

t1, forever [fd 5 / 4 
rt 2]  
t2, forever [fd 1 rt 2]  

if  

true-or-false  

list-to-run  

Runs the instruction list only if the 
true-or-false condition (first input) 
reports true.  

See ifelse.  

Given that these turtles exist on 
the page:  

to go  
t1, forever [fd 1 
check]  
end  

to check  
if 30 < distance "t2  
[towards "t2]  
end  

ifelse  

true-or-false  

list-to-run1  

list-to-run2  

Runs the first instruction list if the 
true-or-false condition (first input) 
is true. Runs the second 
instruction list if the true-or-false 
condition is false.  

See if.  

to quiz  
question [Washington is 
in...]  
ifelse member? answer  
[U.S.A. US USA U.S.]  
    [announce 
[Congrats!]]  
    [announce [Oops]]  
end  

launch  

word-or-list-to-
run  

Runs the input as an independent 
parallel process. If the process is 
launched from the Command 
Center, the cursor reappears 
immediately. Use cancel, the 
Stop All menu item (Edit menu) or 
button (Toolbar), or Ctrl+Break to 
stop the process.  

See forever and Timing and 
Synchronization in the section 
More Techniques in the Help 
System.  

 

 

Given that chopin is an existing 
audio object and fly is a 
procedure:  

launch [chopin]  
fly  
cancel [chopin]  
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listen  Sets the global "turtle who" (the 
turtle obeying instructions from the 
Command Center). This command 
allows you to change the global 
"turtle who" within a process that 
has been launched (for example, 
from a button).  

See also talkto and ask. See also 
Processes and Who in the 
section More Techniques in the 
Help System.  

Given that these turtles exist on 
the page:  

t2, clickon  
fd 30  
t1, listen (inside a 
button)  

not  

true-or-false  

Reports the logical inverse of its 
input.  

See and and or.  

Given that there is a turtle on the 
page:  

ifelse not xcor > 0  
   [setc "red]  
   [setc "blue]  

onreadline  

text-box-name  

instruction  

Sets the designated text box to the 
instruction, which will then be run 
when appropriate text is entered in 
the text box and Enter is pressed. 
The text box name tag changes to 
blue to show that an onreadline 
instruction is active. The second 
input is a procedure or 
MicroWorlds primitive that requires 
a number, word or long word (a 
sequence of characters including 
spaces) as input. Whatever text is 
typed into the text box becomes 
the input for this primitive or 
procedure. Pressing Enter runs 
the complete instruction.  

To turn off the effect of 
onreadline, make the second 
input an empty word as in:  

onreadline text-box-name "  

Onreadline is particularly useful for 
"faking" a Command Center in 
projects for the Web. For more 
information, see Making a Text 
Box into a Command Center in 
the section More Techniques in 
the Help System.  

 

 

 

Given that text1 exist on the page:  

onreadline "text1 "run  

Type fd 50 in that text box and 
press Enter.  
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or  

true-or-false1  

true-or-false2  

 

(or  

true-or-false1  

true-or-false2  

true-or-false3...)  

Reports true if any of its inputs 
report true. If more than two 
inputs are used, or and its inputs 
must be enclosed in parentheses.  

See and and not.  

Given that there is a turtle on the 
page:  

ifelse or xcor > 30 
xcor < -30  
   [setc "red]  
   [setc "blue]  

output (op)  

word-or-list  

Stops the procedure and reports a 
word or list. Output can only be 
used in a procedure.  

to double :x  
op :x + :x  
end  

show double 10  
20  

repeat  

number  

instruction-list  

Runs the list of instructions the 
specified number of times.  

See dotimes and dolist for more 
advanced features.  

Given that there is a turtle on the 
page:  

pd  
repeat 96 [bk 40 fd 40 
rt 4]  

run  

word-or-list-to-
run  

Runs (executes) a word or an 
instruction list.  

See onreadline.  

Given that text1 exists on the page 
and it contains a MicroWorlds EX 
instruction:  

run text1  

setinstruction  

word-to-run  

setinstruction  

instruction-list  

Sets the instruction for the current 
turtle. This is equivalent to typing 
the instructions in the turtle's 
OnClick instruction field in its 
backpack. If the list includes the 
word forever or launch, the 
instruction's mode is set to 
Forever or Once, accordingly. If 
these words are not included, the 
mode is unchanged. If the turtle is 
running an instruction when 
setinstruction is used, the turtle 
will click off.  

See set and get  

 

 

Given that there is a turtle on the 
page:  

to turnoff  
setsh "off  
setinstruction "on  
end  

to turnon  
setsh "on  
setinstruction "off  
end  
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startup  Startup is a special name for a 
public procedure. If your project 
has a procedure named startup, 
this startup procedure is executed 
automatically when you open the 
project. Use this feature to setup 
your project: display the right page 
and start the presentation mode 
for example.  

Given that there is such a page in 
the project. Save the project with a 
different page showing, close and 
reopen the project.  

to startup  
intropage  
presentationmode  
end  

stop  Stops the procedure that is 
running. Stop can only be used in 
a procedure.  

See stopall, stopme, and output. 

Given that there is text box on the 
page:  

to countup :number  
if :number > 100 [stop]  
print :number  
countup :number + 5  
end  

stopall  Stops all running procedures and 
processes, including turtles and 
buttons. Stopall can be used as a 
button, from the Command 
Center, or in a stop rule in a 
procedure. This primitive sets the 
Stop All button in the Toolbar. All 
the processes are stopped, and 
the OnTick processes are paused. 
The OnTick processes resume 
immediately when a new process 
is launched.  

See stop and stopme.  

Given that there are several turtles 
running towards a red area:  

to race  
everyone [if 15 = 
colorunder  
[announce se who "wins  
stopall]]  
end  

stopme  Stops the process in which this 
command was run. Stopme 
cannot be used to stop a turtle 
inside a color instruction. In this 
case, use clickoff instead.  

See stop and stopall.  

Given that these turtles exist on 
the page and that they are close to 
one another:  

t1, forever [fd 1 if 
(distance "t2) > 150 
[stopme]]  

waituntil  

true-or-false-list-
to-run  

Tells MicroWorlds EX to wait until 
true-or-false-instruction-list is 
true before running another 
instruction. The input must be an 
instruction list that reports either 
true or false when it is run.  

See done?.  

 

 

 

Given that these turtles exist on 
the page:  

waituntil [touching? 
"t1 "t2]  
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when  

true-or-false-  

instruction-list  

instruction-list  

Starts an independent parallel 
process that repeatedly tests 
whether the first instruction list 
reports true or false. If it reports 
true, the second instruction list is 
run. To stop a when instruction, 
use cancel (only on the true-or-
false-instruction-list), Stop All, or 
press Ctrl+Break.  

Note: we strongly recommend 
using the Turtle events in 
backpack (When this - Do that) 
instead of this command.  

See Stopping Processes in the 
section More Techniques in the 
Help System.  

Given that there is a turtle on the 
page:  

when [ycor > 0] [bk 40]  
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Variables 
 

Primitive  

Input(s)  

Description  Examples  

clearname  

word  

Clears a global variable from 
memory.  

See clearnames, names, make, 
and name.  

make "speed 5  
make "direction "right  
show :speed  
5  
clearname "speed  
show :speed  
speed has no value  

clearnames  Clears all the global variables from 
memory. MicroWorlds EX doesn't 
clear the variables when you open 
or create a new project. Therefore, 
it may be necessary to use 
clearnames when you start a new 
project.  

See names, clearname, make, 
and name.  

make "speed 5  
make "direction "right  
show :speed  
5  
clearnames  
show :speed  
speed has no value  
show :direction  
direction has no value  

createprojectvar  

word-or-list  

Stands for create project 
variable. Creates a project 
variable represented by a 
command and a reporter. For 
example, if the project variable 
"amount" is created, the command 
setamount sets the variable's 
value, and amount reports its 
value. Project variables are saved 
with your project.  

The Project Tab shows the project 
variables. Individual variables can 
be removed with the right-click 
menu item Remove. You can also 
use the remove command to 
remove a project variable.  

See projectvars, make, remove 
and name. See also Local 
Variables and Global Variables 
in the section Programming in the 
Help System.  

 

 

 

createprojectvar 
"amount  
setamount 22  
show amount  
22  
createprojectvar 
[friends foes]  
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giveturtle  

word  

Assigns a state variable to the 
current turtle and creates a 
command-reporter pair of 
primitives that can be used in the 
current project only: the word set 
followed by the name of the 
variable (for example, giveturtle 
"speed creates a setspeed 
command) and the name of the 
variable (in this example, the 
reporter speed).  

The State Tab of the turtle's 
backpack displays the giveturtle 
variables. The value of the 
variable can also be set by double-
clicking on the variable name in 
the turtle's backpack.  

After a giveturtle instruction, the 
value of the variable is empty until 
it is set.  

See turtlesown and State 
Variables in the section 
Programming in the Help System. 

Given that there is a turtle on the 
page:  

giveturtle "hasrun  
sethasrun "false  
fd 50 sethasrun "true  
ifelse hasrun  
[announce [I'm tired]]  
[fd 50]  

let  

list-of-names-
and-values  

Creates one or many temporary 
variables. The variables exist only 
while the procedure containing the 
let instruction and procedures 
called by this procedure are 
running. The input is a list of 
paired variable names and values. 
Let can only be used in a 
procedure. Use let when you know 
in advance the value of the 
variable.  

See local and Local Variables in 
the section Programming in the 
Help System.  

 

 

 

 

 

 

 

to pythagore :x :y  
let [sqrx :x * :x sqry 
:y * :y]  
op sqrt sum :sqrx 
:sqry  
end  
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local  

word-or-list  

Makes the specified variable local 
to the procedure in which local is 
used. Local can only be used in a 
procedure. Use local when you 
have to perform some calculations 
on a variable within a procedure.  

See let, make, and name.  

Given that there are several 
pages in the project.  

to slideshow  
local "pictures  
make "pictures files 
"jpg  
slideone :pictures  
end  

to slideone :list  
if empty? :list [stop]  
cg  
loadpict first :list  
wait 30  
slideone bf :list  
end  

make  

word  

word-or-list  

Creates a variable named word 
and gives it the value word-or-list. 
These variables keep their values 
as long as you don't clear them or 
quit MicroWorlds EX. They are not 
saved with your project. If you 
want your variables to have 
specific values each time the 
project is loaded, you should have 
a startup procedure. To get the 
variable's value, use the colon in 
front of the variable name.  

See name, thing, clearname, 
names, and createprojectvar. 
See also Global Variables in the 
section Programming in the Help 
System,  

make "friends [Kim Lea 
Bob]  
show :friends  
Kim Lea Bob  
show first :friends  
Kim  

name  

word-or-list  

word  

Creates a variable named word 
and gives it the value word-or-list. 
These variables keep their values 
as long as you don't clear them or 
quit MicroWorlds EX. They are not 
saved with your project.  

See name, thing, clearname, 
names, and createprojectvar. 
See also Global Variables in the 
section Programming in the Help 
System.  

 

 

 

 

name [Kim Lea Bob] 
"friends  
show :friends  
Kim Lea Bob  
show first :friends  
Kim  
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name?  

word  

Reports true if the input is the 
name of a variable.  

See make and name. See also 
Global Variables in the section 
Programming in the Help System. 

Define this procedure. Run the 
other instructions in the 
Command Center.  

to translate :word  
if name? :word  
[op thing :word]  
end  

make "table "mesa  
make "house "casa  
show translate "table  
mesa  

names  Reports the names of all the 
variables with their values.  

make "city "|New York|  
make "friends [Ted 
Lea]  
make "age 12  

projectvars  Stands for project variables. 
Reports the list of currently defined 
project variables.  

See createprojectvar.  

createprojectvar "age  
setage 12  
show projectvars  
age  

thing  

name  

Reports the value of the named 
variable. Corresponds to the use 
of a colon ( : ) preceding a word.  

See make and name. See also 
Global Variables in the section 
Programming in the Help System. 

Define this procedure. Run the 
other instructions in the 
Command Center.  

to translate :word  
if name? :word  
[op thing :word]  
op "Unknown  
end  

make "table "mesa  
make "house "casa  
show translate "table  
mesa  
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turtlesown  

word  

Assigns a state variable to all the 
turtles in the current project. This 
variable can then be set to a 
specific value for each turtle. This 
command creates a command-
reporter pair of primitives that can 
be used in the current project only: 
the word set followed by the name 
of the variable (for example, 
turtlesown "speed creates a 
setspeed command) and the 
name of the variable (in this 
example, speed).  

The State Tab of the turtle's 
backpack displays the turtlesown 
variables. The value of the 
variable can also be set by double-
clicking on the variable name in 
the turtle's backpack.  

After a turtlesown instruction, the 
value of the variable is empty until 
it is set.  

See giveturtle and State 
Variables in the section 
Programming in the Help System. 

Given that these turtles exist on 
the page:  

turtlesown "start  
t1, setstart [-50 -51]  
t2, setstart [-30 -51]  
everyone [setpos 
start]  
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Math 
 

Primitive  

Input(s)  

Description  Examples  

Math 
Operators  

number1 - number2  

Reports the result of number1 
minus number2.  

number1 * number2  

Reports the product of number1 
multiplied by number2.  

number1 / number2  

Reports the result of number1 
divided by number2.  

number1 + number2  

Reports the sum of number1 and 
number2.  

number1 < number2  

Reports true if number1 is less than 
number2.  

word-or-list1 = word-or-list2  

Reports true if word-or-list1 is equal 
to word-or-list2.  

number1 > number2  

Reports true if number1 is greater 
than number2.  

See difference, product, quotient, 
sum, equal?, less?, equal?, 
identical?, greater?.  

Given that a turtle and these 
sliders exist on the page. The 
result is just an example.  

show 5 - 3  
2  
show slider1 - slider2  
42  
show 5 * 3  
15  
show 12 / 4  
3  
show 2 + 4  
6  
show 2 < 3  
true  
show 5 = 3  
false  
show "A = [A]  
false  
show 5 > 3  
true  
if xcor > 100 [rt 180]  

abs  

number  

Stands for absolute. Reports the 
absolute value of its input.  

Given that there is a turtle on the 
page:  

sety abs xcor  
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arctan  

number  

Stands for arc tangent. Reports the 
arc tangent (the inverse function of 
the tangent) of its input.  

See tan and cos.  

Given that a turtle exists on the 
page. The result is just an 
example.  

show arctan heading  
89.8090147756  

cos  

number  

Stands for cosine. Reports the 
cosine of its input.  

See sin and tan.  

Given that a turtle exists on the 
page. The result is just an 
example.  

show cos heading  
0.5  

difference  

number1  

number2  

Reports the result of subtracting 
number2 from number1.  

See - and minus.  

Given that these turtles exist on 
the page. The result is just an 
example.  

show difference 30 40  
show difference  
t1's "heading  
t2's "heading  
30  

exp  

number  

Stands for exponential. Reports the 
number to the power of the 
constant e.  

show exp 1  
2,71828182846  

greater?  

number1  

number2  

Reports true if the first input is 
greater than the second input.  

See less? and >.  

Given that a turtle exists on the 
page:  

ifelse greater? xcor 
ycor  
   [setc "lime]  
   [setc "blue]  

int  

number  

Stands for integer. Reports the 
integer portion of its input.  

See round.  

Given that a turtle exists on the 
page:  

to snap  
setx 30 * int xcor / 
30  
sety 30 * int ycor / 
30  
end  

Put this procedure in a backpack, 
and the command snap in the 
OnClick field. Drag the turtle 
around and click on it.  
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less?  

number1  

number2  

Reports true if the first number is 
less than the second number.  

See greater? and <.  

Given that a turtle exists on the 
page:  

ifelse less? xcor ycor  
   [setc "lime]  
   [setc "blue]  

ln  

number  

Stands for natural logarithm. 
Reports the natural logarithm (the 
logarithm in base e) of the number. 
Inverse of exp.  

See log and exp,  

show ln 100  
4.60517018599  

log  

number  

Stands for logarithm. Reports the 
logarithm of the number.  

See ln and exp.  

show log 100  
2  

minus  

number  

Reports the additive inverse of its 
input. Minus must be used to report 
the additive inverse of a variable 
(minus :num or minus heading 
instead of -:num or -heading).  

See - and difference.  

Given that a turtle exists on the 
page. The result is just an 
example.  

setx minus ycor  
-55  

pi  Reports the constant pi.  show pi  
3,14159265359  
seth 360 / pi  

power  

number1  

number2  

Reports number1 raised to the 
power of number2.  

Given that a turtle exists on the 
page:  

pu home pd  
dotimes  
[i 24]  
  [sety (power :i 2) / 
10  
setx xcor + 1]  

product  

number1  

number2  

(product  

number1  

number2  

number3...)  

Reports the result of multiplying its 
inputs. If more than two inputs are 
used, product and its inputs must 
be enclosed in parentheses.  

show product 10 10  
100  
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quotient  

number1  

number2  

Reports the result of dividing 
number1 by number2.  

show quotient 100 50  
2  

random  

number  

Reports a random non-negative 
integer (including 0) less than 
number. The maximum number is 
9999.  

Given that a turtle exists on the 
page. The result is just an 
example.  

fd random 30 rt random 
60  

remainder  

number1  

number2  

Reports the remainder after 
number1 is divided by number2. 
The remainder of a negative 
number is negative. If number1 
and number2 are non-integers, 
they are rounded to the nearest 
integers.  

Given that a turtle exists on the 
page. The result is just an 
example:  

show remainder 100 3  
1  
show remainder xcor 10  
8  

rerandom  Reproduces the same sequence of 
numbers generated by random. 
After running rerandom, random 
with the same input generates the 
same sequence of numbers the 
next time.  

rerandom  
repeat 2 [show random 
10]  
8  
5  
rerandom  
repeat 2 [show random 
10]  
8  
5  

round  

number  

Reports the number given as input 
rounded to the nearest integer. 
Numbers ending with .5 are 
rounded to the higher integer.  

Given that a turtle exists on the 
page:  

to snap  
setx 30 * round xcor / 
30  
sety 30 * round ycor / 
30  
end  

Put this procedure in a backpack, 
and the command snap in the 
OnClick field. Drag the turtle 
around and click on it.  

sin  

number  

Stands for sine. Reports the sine of 
number degrees.  

See cos and tan.  

Given that a turtle exists on the 
page. The result is just an 
example.  

show sin 45  
0,707106781187  
show sin heading  
-0.866025403784  
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sqrt  

number  

Stands for square root. Reports the 
square root of its input.  

show sqrt 100  
10  

sum  

number1  

number2  

 

(sum  

number1  

number2  

number3...)  

Reports the sum of its inputs. If 
more than two inputs are used, 
sum and its inputs must be 
enclosed in parentheses.  

See +.  

Given that a turtle exists on the 
page. The result is just an 
example.  

show sum 10 10  
20  
show sum xcor ycor  
212  

tan  

number  

Stands for tangent. Reports the 
tangent of its input.  

See sin and cos.  

Given that a turtle exists on the 
page. The result is just an 
example.  

show tan heading  
-1.73205080757  
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Input – Output 
 

Primitive  

Input(s)  

Description  Examples  

announce  

word-or-list  

Displays the word-or-list 
message in an alert box. Clicking 
OK closes the box. If you drag the 
alert box to a new position while it 
is being displayed, this is the 
position where the next alert box 
is opened in the project.  

See question and answer.  

announce [Guess what's 
in the package...]  

answer  Reports the contents of the last 
answer typed in the question 
dialog box. It also reports special 
values after a dialog box have 
been used: OK if the OK button 
was used, the empty list if the 
Cancel button was used, or the 
button's label if a different button 
was used. The value reported by 
answer is always overwritten by 
the last usage of a question or a 
dialog box.  

See question and Dialog Boxes 
in the section Fundamentals in 
the Help System.  

Given that question was used 
with a yes-no answer:  

if answer = "yes  
   [setsh "happy]  
if answer = "no  
   [setsh "sad]  

closeworksheet  Closes and saves the current 
Microsoft Excel file. This is the 
Excel file that was opened with the 
command openworksheet.  

See getcell and setcell.  

MicroWorlds EX will create this 
worksheet if it doesn't exist:  

openworksheet "graph 
"sheet1  
setcell 1 2 10  
closeworksheet  

getcell  

row-number  

column-number  

Reports the value of the cell 
specified by the row-number and 
column-number of the current 
Microsoft Excel worksheet. Note 
that the command 
openworksheet makes an Excel 
worksheet available to 
MicroWorlds EX.  

See also setcell and 
closeworksheet.  

 

MicroWorlds EX will create this 
worksheet if it doesn't exist. The 
result is just an example:  

openworksheet "graph 
"sheet1  
show getcell 1 1  
50  
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key? 

 

Reports true if a key is being 
pressed on the keyboard. Use 
stopall to reset key? to false.  

See readchar.  

Given that there are several 
pages in the project (click on the 
page before you start because 
readchar works when the page is 
the current "active" area:  

to flip  
forever [nextpage wait 
10]  
waituntil [key?]  
cancel [nextpage wait 
10]  
end  

mousepos  Stands for mouse position. 
Reports the page coordinates 
representing the current mouse 
position on the screen.  

See setpos.  

Given that there is a turtle on the 
page:  

setpos mousepos  

openworksheet  

pathname  

sheet  

Opens the specified file in 
Microsoft Excel on the specified 
worksheet. The first input must be 
the name of an Excel file in the 
current directory or a full or 
relative path. The second input 
must be the name of the sheet.  

The Excel related primitives only 
work if you have this program 
available on your computer.  

See getcell, setcell, and 
closeworksheet.  

MicroWorlds EX will create this 
worksheet if it doesn't exist:  

openworksheet "cards 
"sheet1  

question  

word-or-list  

Opens a dialog box displaying the 
question and an area to type the 
answer. Answer reports what was 
typed in the dialog box. If you 
write a very long question, only 
the part that fits is displayed. If 
you drag the dialog box to a new 
position while the question is 
being displayed, this is the 
position where the next question 
dialog is opened in the project.  

See answer.  

 

 

 

 

question [Are you in a 
good mood today? 
(answer yes or no)]  
question [|Are you in 
a good mood today?  
(answer yes or no)|]  
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readchar  Pauses the execution and waits 
for a character to be typed on the 
keyboard.  

See key? and onreadline.  

Given that there is a turtle on the 
page. Click on the page before 
you start because readchar 
works when the page is the 
current "active" area:  

to direct  
let [key readchar]  
if (ascii :key) = 37  
    [seth 270]  
if (ascii :key) = 38  
    [seth 0]  
if (ascii :key) = 39  
    [seth 90]  
if (ascii :key) = 40  
    [seth 180]  
end  

Animate the turtle and create a 
button with the instruction Direct 
in Forever mode. You can now 
use the arrow keys to control the 
turtle.  

setcell  

row-number  

column-number  

value  

Sets the value of the specified cell 
(in row-number, column-
number) in the current Microsoft 
Excel worksheet. Note that the 
command openworksheet makes 
an Excel worksheet available to 
MicroWorlds EX.  

The Excel related primitives only 
work if you have this program 
available in your computer.  

See getcell and closeworksheet. 

Given that this worksheet exists:  

openworksheet "cards 
"sheet1  
setcell 1 1 50  
setcell 1 2 100  
setcell 1 3 
"|=AVERAGE(A1:B1)|  
show getcell 1 3  
75  
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Time 
 

Primitive  

Input(s)  

Description  Examples  

resett  Stands for reset timer. Resets the 
timer to 0. The timer starts when 
you start up MicroWorlds EX.  

See timer.  

Define this procedure and run the 
other instructions in the Command 
Center.  

to reflex  
resett  
setnum1 1 + random 10  
setnum2 1 + random 10  
question  
(se [What is] num1  
   "times num2 [?])  
ifelse answer = num1 * 
num2  
   [announce se timer / 
10 "sec]  
   [announce [Wrong 
answer]]  
end  

Type this in the Command Center:  

createprojectvar "num1  
createprojectvar "num2  
reflex  

timer  Reports a number representing the 
time elapsed since MicroWorlds EX 
started, or since the last resett 
command was run. The number is 
in tenths of a second.  

See resett.  

Define this procedure and run the 
other instructions in the Command 
Center.  

to reflex  
resett  
setnum1 1 + random 10  
setnum2 1 + random 10  
question  
(se [What is] num1  
   "times num2 [?])  
ifelse answer = num1 * 
num2  
   [announce se timer / 
10 "sec]  
   [announce [Wrong 
answer]]  
end  

createprojectvar "num1  
createprojectvar "num2  
reflex  
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wait  

duration  

Causes a pause in the execution of 
a program or instruction. Duration 
is measured in 10ths of a second.  

Given that there is a turtle on the 
page:  

forever [fd 1 wait 1]  
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Sound 
 

Primitive  

Input(s)  

Description  Examples  

note  

number-or-list-
of-numbers  

duration  

Plays a note using the current 
instrument. The first input is the 
MIDI note number and the second 
is the duration in tenths of a 
second. If the first input is a list of 
numbers, note plays a chord. 
Middle C is 60. The maximum 
number for note is 127; the 
maximum duration is 255. There 
can be no more than 16 numbers in 
list-of-numbers.  

See rest.  

note 60 4  
note [72 76 79 84] 15  

rest  

duration  

Inserts a rest in a sequence of 
notes. The duration is in tenths of 
a second, and has a maximum of 
255.  

See note.  

to song  
note 60 5  
note 62 5  
note 64 5  
rest 10  
note 60 5  
note 62 5  
note 60 15  
end  

setinstrument  

name-or-
number  

Sets the instrument for the next 
note command. There are 7 
instrument names: piano, 
harpsichord, vibraphone, guitar, 
violin, clarinet, and kalimba. You 
can also use any number from 1 to 
128. This setting is not saved with 
the project. If needed, put a 
setinstrument instruction in a 
startup procedure. See Startup in 
the Help System.  

setinstrument "violin  
note 60 10  
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Workspace 
 

Primitive  

Input(s)  

Description  Examples  

recycle  Frees up unused MicroWorlds EX 
memory space. MicroWorlds EX 
automatically recycles by itself to 
free up space. Therefore, only use 
the recycle command when you do 
not want the automatic recycle to 
occur when you are running a 
program.  

 
See space.  

show space recycle 
show space  

space  Reports the amount of free 
MicroWorlds EX space in bytes.  

See recycle.  

show space recycle 
show space  

 


